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Safety Information

Before installing this product, read the Safety Information book.

Antes de instalar este produto, leia o Manual de Informações sobre  Seguranca.

Læs hæftet med sikkerhedsforskrifter, før du installerer dette produkt.

Lue Safety Information -kirjanen, ennen kuin asennat tämän tuotteen.

Avant de procéder à l'installation de ce produit, lisez le manuel Safety Information.

Vor Beginn der Installation die Broschüre mit Sicherheitshinweisen lesen.

Prima di installare questo prodotto, leggere l'opuscolo contenente le informazioni 
sulla sicurezza.

Lees voordat u dit product installeert eerst het boekje met veiligheidsvoorschriften.

Les heftet om sikkerhetsinformasjon (Safety Information) før du installerer dette 
produktet.

Pred instalací tohoto produktu si prectete prírucku bezpecnostních instrukcí.

Przed zainstalowaniem tego produktu należy przeczytać broszurę Informacje Dotyczące
Bezpieczeństwa.
© Copyright IBM Corp.  2000  v



 

Antes de instalar este produto, leia o folheto Informações sobre Segurança.

Antes de instalar este producto, lea la Información de Seguridad.

Läs säkerhetsinformationen innan du installerar den här produkten.

Перед установкой продукта прочтите брошюру по технике безопасности
(Safety Information).

Pred inštaláciou tohto produktu si pre ítajte Informa nú brožúrku o bezpe nosti.

Preden namestite ta izdelek, preberite knjižico Varnostne informacije.

Installálás el tt olvassa el a Biztonsági el írások kézikönyvét !
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About this book

This book provides information and instructions for unpacking and setting up the IBM® 
Netfinity® High-Availability (HA) Cluster rack solution.  It also provides information on 
installing and configuring the cluster solution.

This book is intended for experienced users who will be involved in setting up and 
administering clustering installations. 

How this book is organized
Chapter 1, “Introduction,” on page 1, provides an overview of the IBM Netfinity HA 
4500R Cluster solution.  

Chapter 2, “Installing the Netfinity HA 4500R Cluster hardware,” on page 3,  contains 
instructions for unpacking and installing the Netfinity HA 4500R Cluster components. 

Chapter 3, “Configuring the Netfinity HA 4500R cluster,” on page 13, provides infor-
mation on configuring the cluster.

Chapter 4, “Troubleshooting and initial system settings,” on page 33, provides infor-
mation on the initial software configuration settings for Windows 2000.  This chapter 
also provides troubleshooting information on how to recover from problems you might 
encounter while installing the IBM Netfinity HA 4500R Cluster solution.

Appendix A, “Getting help, service, and product information,” on page 43, provides 
information on getting help, service, and other product information.

Appendix B, “Product notices,” on page 45, contains trademarks and general-informa-
tion notices.

Related publications
During the installation and set up of the IBM Netfinity HA 4500R Cluster, you might 
need to refer to one or more of the publications in the publication pack that arrived 
with the rack.

For additional information about these publications, call 1-800-879-2755 in the United 
States and Puerto Rico, or call 1-800-426-4968 in Canada.  In all other countries, con-
tact your IBM reseller or marketing representative.
© Copyright IBM Corp.  2000  vii
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Chapter 1. Introduction

The IBM Netfinity High Availability (HA) 4500R Cluster solution is a group of software 
and hardware components interconnected and configured together to provide users 
with uninterrupted applications and data access.

A cluster is a type of parallel or distributed system that consists of interconnected 
computers used as a single, unified computing resource.  This group of computers is 
linked together in such a way that they share and manage a set of resources that can 
support a number of users at the same time.

This high-availability clustering solution is based on a two-node cluster, where both 
nodes, or servers, can access the same storage devices, but only one server at a time 
controls the storage devices shared by both servers.  If one server fails, the second 
server automatically assumes control of the failed server resources, while still control-
ling its own resources.  The failed server can then be repaired offline without the loss 
of time or work efficiency, because access to that server’s data and applications is still 
available.

When the failed server is operational again, you can place it back into the cluster, the 
resources are reallocated between the two servers and the cluster will then resume 
normal operations.

The IBM Netfinity HA 4500R Cluster uses two Netfinity 4500R 3U servers with 667 
MHz Pentium III micro-processors.  Each server has up to 4 GB of SDRAM memory 
and is connected to a Netfinity EXP200 Storage Expansion Unit that holds up to 10 
hot-swappable hard drives.  Clustering software also comes pre-installed on each 
server.

The IBM Netfinity HA 4500R Cluster solution is installed using Microsoft® Windows 
2000 Advanced Server or Windows NT 4.0 Enterprise Edition.

The Netfinity HA 4500R Cluster provides you with a prepackaged solution, eliminating 
the need for you to purchase and integrate multiple components.  This cluster solution 
offers you one-stop shopping for system reliability, redundancy, and uninterrupted 
operations. 

The Netfinity HA 4500R Cluster comes with a limited three-year on-site warranty.  In 
the U.S. and Puerto Rico, call IBM at 1-800-772-2227, or in Canada, call 1-800-565-
3344 if you need assistance.  In all other countries, contact the IBM support organiza-
tion that service your area, your IBM marketing representative, or your IBM reseller.

Netfinity HA 4500R cluster components
The following table lists the components included in the Netfinity HA 4500R cluster 
rack configuration:

Table 1. 4500R cluster components 

Quantity Component Usage

 Server Nodes

2 Netfinity 4500R 667 MHz, 128MB RAM Cluster nodes, onboard Ethernet for public 
network access

4 Netfinity 9.1 GB 7200RPM Ultra-3 SCSI hard disk drive - hot swap Two per node for RAID 1 
© Copyright IBM Corp.  2000  1



 

4 Netfinity ServeRAID-3L Ultra2 SCSI Adapter 2 Two per node: one for shared storage 
controller and one for RAID 1 (mirrored) 
internal server drives

2 Netfinity 10/100 Ethernet Adapter Clustering Heartbeat - one per node 

Storage Subsystem

1 Netfinity EXP200 Hard Disk Drive Storage One EXP200 for shared storage, maximum 
of 10 Ultra2 hard disk drives

5 Netfinity 9.1 GB 10K RPM Ultra2 SCSI hard disk drive  - hot swap RAID 5 shared storage in EXP200

1 Netfinity 2M Ultra2 SCSI cable Server to EXP200 (EXP200 comes with one 
2M cable) 

1 Netfinity EXP200 350 Watt redundancy power supply Required for redundancy (pre-installed)

Rack Unit, Monitor, Console Server Switch

1 NetBAY 22 rack 22U rack unit

2 Low Voltage Power Distribution Unit (PDU) Preinstalled

1 T54a Flat Panel Monitor

1 Netfinity Rack Keyboard Tray Preinstalled

1 Netfinity Flat Panel Monitor Rack Mount Kit II 

1 Space Saver Keyboard

1 Netfinity Console Server Selector (4-port) Preinstalled

2 Console Cable Set One console cable set per node

Cluster Interconnect

1 Ethernet Cluster Interconnect Cable Ethernet Crossover cable for interconnection 
between Netfinity 10/100 Ethernet Adapters 
- Heartbeat

Preloaded Software - Select an Option

2 Microsoft Windows NT Server 4.0 EE with MSCS NOS and cluster middleware preloaded

2 Microsoft Windows 2000 Advanced Server NOS and cluster middleware preloaded

Options

2 Netfinity 667MHz, 256 KB upgrade with Pentium III Microprocessor Symmetric multiprocessing (SMP) for 
Netfinity nodes

2 Netfinity 128MB SDRAM ECC RDIMM Memory upgrade

5 Netfinity 9.1 GB 10K RPM Ultra2 SCSI hard disk drive  - hot swap RAID 5 shared storage in EXP200

1 Netfinity Advanced Systems Management PCI Adapter One per cluster

1 Netfinity Advanced Systems Management Interconnect One included with PCI adapter, one option 
required for second system

2 PCI V90 56 Data/FAX Modem Required for communications

1 Tape drive Tape backup

1 Uninterruptable power supply (UPS) APC uninterruptable power supply

Table 1. 4500R cluster components 

Quantity Component Usage
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Chapter 2. Installing the Netfinity HA 4500R Cluster hardware

This chapter contains instructions for unpacking and installing the Netfinity HA 4500R 
Cluster hardware. 

Unpacking the cluster components
Before you unpack the cluster components, be sure to read the IBM Netfinity Rack 
Planning and Installation Guide for information on the following: 

• Understanding the rack specifications and requirements

• Preparing a layout for the rack

• Preparing the physical site for the rack

To unpack your Netfinity HA 4500R Cluster, do the following: 

• Review the rack unpacking instructions that are attached to the outside of the 
rack packaging materials for details on how to unpack the rack 

• Carefully unpack the remaining components from the other packages and com-
pare the components with the following inventory checklist

Inventory checklist
Take an inventory of items as you unpack them to ensure that you have all of the clus-
ter components.  The following is a list of items shipped for all Netfinity HA 4500R 
Cluster installations.  If any items are missing or damaged, contact your place of pur-
chase: 

Note: Some cluster components, such as slide rails, come preinstalled in the rack 
cabinet.

 

• One Netfinity 9306 Model 200 NetBAY22 rack cabinet

• One Rack stabilizer bracket (located in the cardboard box in the rack)

• Two Netfinity 4500R servers (slide rails preinstalled in the rack)

Statement 4

≥18 kg (37 lbs) ≥32 kg (70.5 lbs) ≥55 kg (121.2 lbs)

CAUTION:
Use safe practices when lifting.
© Copyright IBM Corp.  2000  3



 

• One Netfinity EXP200 expansion unit (rails preinstalled in the rack)

• One Netfinity console-server selector switch (preinstalled in the left side of the 
rack)

• Two Netfinity power distribution units (PDU) (preinstalled - one in each side of the 
rack)

• One Netfinity keyboard tray (preinstalled in the rack)

• One space-saver keyboard

• One T54a flat panel monitor

• One Netfinity Flat Panel Monitor Rack Mount Kit II (for installing the monitor in the 
keyboard tray)

• Two cable-management arms (for routing server cables)

• Two hinge pins (for attaching the cable-management arms to the rack)

• Six 120 V ac power cables (for connecting power to the monitor, selector switch, 
EXP200, and both servers)

• One Ethernet crossover cable (for connecting the Netfinity 10/100 Ethernet 
Adapters to each other)

• Two external LVD SCSI cables (for connecting the servers to the EXP200)

• Cable clamps (for cables connected to the servers)

• Cable-retainer brackets (one for each server for cable routing)

• M6 screw package (for securing components in the rack)

• Cable straps (for securing cables within the rack)

• User and Installation Guides for all cluster components

• IBM Netfinity Safety Information book

• This documentation

Your cluster might also include an APC uninterruptable power supply (UPS).  If a UPS 
is part of your cluster installation, the mounting rails will be preinstalled in the rack for 
you.

Preinstallation procedures
Before you begin, do the following: 

• Read "Handling static-sensitive devices".

• Read "Tool requirements".

Handling static-sensitive devices
Some of the cluster components are electrostatic discharge (ESD) sensitive.  Take 
precautions to void damage from static electricity.  For details on handling ESD-sensi-
tive devices and components, refer to the following Web site and use a search term of 
ESD:  http://www.ibm.com

Tool requirements
To install the Netfinity HA 4500R Cluster components, you will need the following 
tools: 
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• A medium flat-blade screwdriver

• A large flat-blade screwdriver

• A medium phillips screwdriver

• A 12-mm open-end wrench 

Installing the 4500R cluster components
• Review the documentation that comes with your rack cabinet

• Maintain clearance around your devices for air circulation

• Ensure that the room air temperature is below 35ºC (95ºF)

• Install devices starting from the bottom of the rack

• Do not extend more than one device out of the rack at the same time

• Do not place any object weighing more than 50 kg (110 lbs.) on top of rack-
mounted devices

• Remove the rack doors and side panels, if necessary, to provide easier access 
during installation

• Connect all power cords to properly wired and grounded electrical outlets

• Take caution to prevent overloading the power outlets when you install multiple 
devices in a rack

Use the following procedure to install the cluster components in your rack:

1. Before installing any devices in the rack, roll the rack to the location where you 
will connect your cluster to the local network. 

Attention: You must connect the servers in your cluster to active ports on your 
public network before you turn on the servers and configure the software.  Make 
sure that the location you choose for your rack will allow these network connec-
tions to be made.

2. Once you have located your rack, use a 12-mm open-end wrench to lower the 
four leveling pads on the bottom of the rack until they make firm contact with the 
floor. 
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3. Place the rack stabilizer bracket so that the holes in the vertical flange align with 
the threaded holes on the bottom-front of the rack; then, secure the stabilizer 
bracket to the rack with the four screws that come in the box with the bracket. 

Note: If necessary, bolt the bottom of the stabilizer bracket to the floor.  Other-
wise, use the bracket plugs to fill the holes in the stabilizer bracket.

4. If a UPS came as part of your cluster, you must install it first in the bottom of the 
rack.  Slide the UPS into the bottom of the rack and secure it to the rack with the 
provided M6 screws. 

Note: The batteries inside of the UPS are disconnected before shipping.  Refer to 
the documentation that comes with the UPS for instructions on how to 
reconnect the batteries before you turn on your UPS or any devices that 
are connected to it.

5. The EXP200 expansion unit installs in the bottom of your rack, or just above a 
UPS if you installed one in step 4.  Before installing the EXP200, remove both 
rear screws from the preinstalled rails in the rack and save them. 
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 Remove the white screws and wingnuts from the bezel and set the bezel aside; 
then, slide the expansion unit fully into the rack.  Align the bezel locator pins and 
secure the bezel to the rack with two M6 screws; then, secure the rear of the unit 
with the two screws that you removed in the beginning of this step. 

Notes:

a. The illustration shown here is of an EXP200 with its hard drives, power sup-
plies, and fans removed.  If you need to reduce the weight of the EXP200 for 
easier installation into the rack, refer to the EXP200 documentation that 
comes with your cluster for instructions on how to temporarily remove these 
items during installation.

b. Even if you do not remove items from the EXP200, verify that all hard drives 
are properly seated.

6. Install the cable-management arms for both servers before installing either server.  
Server 2 installs just above the EXP200 in your rack on the slide rails preinstalled 
in the rack, and Server 1 installs just above Server 2, also on preinstalled slide 
rails. 

 Use the hinge pins to attach each cable-management arm to the hinge bracket 
on the preinstalled slide rails for both servers. 

Note: If you need to access the rear of a server, after you install it, you must 
rotate the lever to the vertical position so that you can pull the arm away 
from the server.  Otherwise, the lever must be in the horizontal position 
inside of the rack to prevent the cables from touching the rear rack door.

Rear screws
Bezel wingnuts

Front
screws

Lever

Hinge pin

Cable management arm
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7. Extend the slide rails for Server 2 fully out of the rack; then, lift the server above 
the rails and rest the rack-support wheels on the slide rails. 

Attention: Be careful not to place your fingers around the wheels when you lower 
the server onto the rails.

8. Secure the server to the rails with three M4 screws per rail; then, remove the 
rack-support wheels and store them in a safe place for future use. 

9. Use two M4 screws to install the cable-retainer bracket on the server; then, install 
the cable clamps to use later when routing cables. 

Note: Your cluster comes with enough cable clamps to use on both servers.  Do 
not install all of the cable clamps on the same server; instead, divide the 
cable clamps evenly between both servers.

Rack support wheels

Rack support wheels

Cable clamps

Cable retainer

bracket
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10. Press the latches on both rails inward so that you can slide the server into the 
rack; then, push the server until both release latches on the front of the server 
lock into place on the front of the rails.

11. Repeat step 7 through step 10 to install Server 1 just above Server 2 in the rack.

12. The T54a flat panel monitor installs in the preinstalled keyboard tray in your rack.  
Refer to the IBM Netfinity Flat Panel Monitor Rack Mount Kit II documentation for 
installation instructions for your monitor and space-saver keyboard; then, return 
here to cable your cluster components.

Cabling the 4500R cluster components
• Do not run cables in front of or behind other devices that will prevent service 

access to those devices

• Label all cables (all cables are pre-labeled except for the power cables) so that 
they are clearly distinguishable from each other

• When installing devices mounted on sliding rails, such as servers or the keyboard 
tray: 

— Run the cables neatly along equipment cable-management arms and tie the 
cables to the arms using the cable straps provided 

— Leave enough slack so that the device can fully extend without putting a 
strain on the cables

— Secure the cables so that the device can retract without pinching or cutting 
the cables

• When installing devices mounted on non-sliding rails: 

— Run the cables neatly along the rack posts

— Use the cable straps provided to secure the cables to the posts

• Make sure that the cables cannot be pinched or cut by the rack rear door or other 
devices

• Run external cables through the opening in the bottom of the rack

Make sure that the power switches on all devices are off before connecting any 
cables; then, use the following procedure to cable your 4500R cluster components: 
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1. Connect the flat panel monitor power cable to either PDU or to the UPS; then, 
connect the flat panel monitor and space-saver keyboard to the appropriate ports 
on the console-server selector switch as indicated below. 

2. Connect the power cable for the console-server selector switch to either PDU or 
to the UPS.

3. Connect the monitor, keyboard, and mouse cable (labeled 1A) from the Server 1 
ports on the selector switch to the appropriate ports on Server 1; then, connect 
the monitor, keyboard, and mouse cable (labeled 2A) from the Server 2 ports on 
the selector switch to the appropriate ports on Server 2. 

Note: Make sure that you properly route all cables that you connect to a server 
along the server cable-management arm for that server.

4. Connect a power cable to each server; then, connect the server power cables to a 
PDU or to the UPS. 

Note: To provide redundant power protection against power failures for clusters 
without a UPS, connect one server to the PDU on the left side of your rack; 
then, connect the other server to the PDU on the right side of your rack.

5. Connect two power cables to the EXP200; then, connect both power cables to a 
PDU or to the UPS. 

One

K M

Three Four

K M K MK M

Two

Aux.

Reset

Im
po

rt
an

t
In

fo
rm

at
io

n

1
0

Power cord
connector

Power
switch

Space-saver
keyboard and mouse

Flat panel
monitor

Server 1
monitor

Server 1
keyboard

Server 2
keyboard

Server 1
mouse

Server 2
mouse

Server 2
monitor

Cable management arm
Keyboard

Video

Built-in ethernet

Mouse

Power
connection

PCI slot 1 - ethernet PCI slot 3 - SCSI RAID
PCI slot 4 - SCSI RAID

For Windows NT installations, the removal of the label covering the power 
connectors on each server constitutes acceptance of the Microsoft Win-
dows NT Licensing Agreement.  If you do not agree or accept the agree-
ment, contact your IBM representative.

Attention - License Agreement
 10 IBM® Netfinity® HA4500R C
luster: Installation Guide  



Note: To provide redundant power protection against power failures for clusters 
without a UPS, connect one power cable to each of the two PDUs installed 
in your rack.

6. Connect SCSI bus 1 connector on the EXP200 to the Server 1 RAID adapter in 
PCI Slot 4 using the LVD SCSI cable labeled 3A; then, connect SCSI bus 2 con-
nector on the EXP200 to the Server 2 RAID adapter in PCI Slot 4 using the cable 
labeled 3B.

7. Connect the Server 1 built-in Ethernet Controller to an active port on a hub that is 
part of your public network; then, connect the Server 2 built-in Ethernet Controller 
to another active port on a hub that is part of your public network. 

Note: You do not have to connect both servers to the same hub, as long as they 
are connected to hubs on the same public network.

8. Connect the provided Ethernet crossover cable between the Server 1 Ethernet 
10/100 Adapter in PCI Slot 1 and the Server 2 Ethernet Adapter in PCI Slot 1 to 
interconnect the cluster. 

Attention:  You must connect the servers in your cluster to active ports on your 
public network, and connect the servers to each other, before you turn on the 
servers and configure the software.  Failure to do this will cause your software 
configuration to fail.

9. Once you have completed cabling your 4500R cluster, you can install the M6 
security screws that hold the servers in your rack. 

10. Plug both PDUs or the UPS into properly wired and grounded electrical outlets. 

You have completed cabling your Netfinity 4500R Cluster and are ready to per-
form the software configuration.  Continue with Chapter 3, “Configuring the Netfin-
ity HA 4500R cluster,” on page 13.

SCSI Bus 1 connector SCSI Bus 2 connector

Power connectorPower connector

Power switchPower switch

Release latch

Security screw
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Chapter 3. Configuring the Netfinity HA 4500R cluster

The IBM Netfinity HA 4500R Cluster comes with the base operating system for Win-
dows 2000 Advance Server or Windows NT 4.0 Enterprise Edition already installed.

• If you are configuring this HA Cluster to use Windows 2000 Advanced Server see 
“Configuring the servers using Windows 2000 Advanced Server”

• If you are configuring this HA Cluster to use Windows NT 4.0 Enterprise Edition, 
see “Configuring the servers using Windows NT 4.0 Enterprise Edition” on page 
18

Configuring the servers using Windows 2000 Advanced Server
Note: You will need the 25-character Product Key (Certificate of Authenticity) num-

bers for both Server 1 and Server 2 to configure the Netfinity HA 4500R Cluster 
servers.   The Product Key numbers are located on top of the servers at the 
rear.

Before you begin the configuration process, you need to do the following: 

• Keep in mind the following: 

— Ensure that the cables and power cords are connected properly.

— Ensure that the servers are connected to a working public network.

— Have the 25-character Product Key (Certificate of Authenticity (COA)) num-
ber available when you start the servers. You will need it later.

— Be sure to configure Server 1 before you configure Server 2.

• Power on the cluster components in the following sequence: 

1. The PDU and/or UPS

2. The EXP200

3. The console server selector switch

4. The flat panel monitor

5. Server 1

6. Server 2

The Windows 2000 Advanced Server clustering setup for Netfinity HA 4500R Cluster 
will consist of three phases: 

• Phase 1 - personalizing the basic operating system

• Phase 2 - advance operating system configuration (for example, setting up the 
domain controllers)

• Phase 3 - cluster configuration

Configuring server 1
To configure Server 1, do the following: 

1. Ensure that Server 1 and Server 2 are powered on. 

The Windows 2000 Setup program automatically starts the Windows 2000 oper-
ating system.

2. When the Windows 2000 Server Setup window displays, click Next.

3. When the License Agreement window displays, review the information. Then to 
continue, click I Accept This Agreement; then, click Next.
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4. When the Personalize Your Software window displays, type your full name and 
company or organization in the User Name and Organization fields; then, click 
Next.

5. When Your Product Key window displays, type in the 25-character product key 
(Certificate of Authenticity) number in the Product Key field; then, click Next. 

The setup program takes control. Several screens later, the Completing the Win-
dows 2000 Setup Wizard displays.

6. When the Completing the Windows 2000 Setup Wizard window displays, click 
Finish. 

The setup program has completed Phase 1 - personalizing the basic operating 
system.

The system reboots the operating system and the setup program begins Phase 2 
- advanced operating system configuration.

At this stage in the process, you can choose to configure the server into the net-
work in two ways. You can configure the server as a domain controller or you can 
configure the server as a member of another domain in the network.

If you want to configure the server as a domain controller, continue with the fol-
lowing steps. If you want to configure the server as a member of an existing 
domain, see “Configuring the server as a member of an existing domain” on page 
15. Once you are done, follow step 4., below, through step 25 on page 15 on con-
figuring the server as a domain controller.

To configure the server as a domain controller, do the following: 

1. From the desktop, double-click the Create Domain icon. 

The Configuration Active Directory wizard starts. At this stage, the setup program 
is configuring the server as a domain controller.

2. You might receive an error message if the server is not connected to a network 
correctly. If you get a message that says: "could not form the domain", connect 
the server to the network correctly and continue clicking Next until you are 
prompted to enter your administrative password. Type in the word password in 
lowercase in the Password field; then, click Next.

3. The Insert Disk window displays. Change the path from D:\i386 to C:\i386 then, 
click OK. 

The setup program configures the Active Directory. When complete, the system 
automatically shuts down and reboots. When the system comes up again, the 
setup program starts the cluster configuration phase.

4. When the Welcome to Windows window displays, press Ctrl+Alt+Delete. The 
system reboots.

5. When the Log On to Windows window displays, type the word password (in low-
ercase) in the Password field; then, click OK.

6. The Windows 2000 Configuring Your Server window displays. Close this win-
dow.

7. Run the setup.exe in the path c:\ibm to install Microsoft Clustering Services and 
IBM ServeRAID Clustering Support.

8. When the IBM ServeRAID NT Cluster Solution information window displays, 
click OK.

9. When the Welcome window for IBM ServeRAID NT Cluster Solution window 
displays, click Next.

10. When the IBM ServeRAID Cluster Configuring Wizard window displays, click 
Next.
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11. When the Cluster Service Configuring Wizard window displays, click Next. The 
setup program is installing cluster services.

12. When the Hardware Configuration window displays, click I Understand; then, 
click Next.

13. When the Create or Join Cluster window displays, ensure that the first radio but-
ton is selected; then, click Next.

14. When the Cluster Name window displays, type in a name for the cluster in the 
Cluster Name field; then, click Next.

15. When the Select an Account window displays, type in a user name and pass-
word for the domain account in the User Name and Password fields; then, click 
Next.

16. When the Configure Cluster Network window displays, click Next.

17. When the Network Connections windows displays, ensure that for the IBM Net-
finity 10/100 Ethernet Adapter, you select the Internal cluster communications 
only (private network) radio button; then, click Next.

18. When the next Network Connections window displays, ensure that for the IBM 
Netfinity Fault Tolerance PCI Adapter, you select the all communications 
(mixed network) radio button; then, click Next.

19. When the Internal Cluster Communication window displays, ensure that the 
network name for the IBM Netfinity 10/100 Ethernet Adapter is the first one in the 
network list; then, click Next.

20. When the Cluster IP Address window displays, type the IP Address for the man-
agement of the cluster in the IP Address field (use the cluster IP Address listed in 
Table 2 on page 33); then, click Next.

21. When the Completing the Cluster Service Configuration Wizard window dis-
plays, click Finish. 

22. When the Cluster information window displays and indicates that the cluster ser-
vice has started successfully, click OK.

23. The configuration that was shipped with the cluster must use the Q: drive as the 
quorum resource. When the IBM ServeRAID Cluster Configuration Wizard win-
dow displays, select the Q: drive and click Next.

24. When the window indicating that the configuring wizard has completed configur-
ing the cluster displays, click Finish.

25. The IBM ServeRAID NT Cluster Solution window displays and indicates that the 
setup program has completed the installation of IBM ServeRAID Cluster Solution. 
Click Finish. 

You have successfully completed cluster configuration of Server 1.

Configuring the server as a member of an existing domain
Your servers were shipped pre-configured with a network configuration that might not 
be compatible with the network environment in which the servers will become a mem-
ber of. You will need to modify the network connection settings to make the Server 
1ccessible in an existing domain (refer to Table 2 on page 33 for the initial configura-
tion settings). Although there are two network connections, you will only need to mod-
ify one of the network connections to make the Server 1ccessible in an existing 
domain.

Note: The procedures that follow apply to both Server 1 and Server 2.

To configure the server as a member of an existing domain, do the following: 

1. From the desktop, right-click on My Network Places icon; then, click Properties.
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2. Right-click on the network connection associated with the IBM Netfinity Fault Tol-
erance PCI Adapter; then, click Properties.

3. When the Local Area Connection Properties window displays, select Internet 
Protocol (TCP/IP); then, click Properties.

4. Contact your network or system administrator to obtain the information needed to 
configure the internet protocol for this server.

5. From the desktop, right-click on My Computer icon; then, click Properties.

6. When the System Properties window displays, select the Network identifica-
tion tab; then, click Properties.

7. When the Identification Changes window displays, select the Domain radio but-
ton and type the name of the domain that you want the server to be a member of 
in the Domain text field; then, click OK.

8. When the Domain User name and Password window displays, type the name 
and password of an account to join the domain in the Name and Password fields; 
then, click OK.

9. When the Network Identification information window displays welcoming you to 
the domain that you have become a member of, click OK.

10. When the Network Identification information window displays indicating that you 
must restart your computer for the changes to take effect, click OK.

11. Click OK to save the changes and close the System Properties window.

12. When the System Setting Changes information window displays indicating that 
you must restart the computer for the changes to take effect, click Yes. 

You have successfully configured the server as a member of an existing domain.

Configuring server 2
To configure Server 2, do the following: 

1. Ensure that Server 1 and Server 2 are powered on.

2. When the Windows 2000 Server Setup window displays, click Next.

3. When the License Agreement window displays review the information. Then to 
continue, click I Accept This Agreement; then, click Next.

4. When the Personalize Your Software window displays, type your full name and 
company or organization in the User Name and Organization fields; then, click 
Next.

5. When Your Product Key window displays, type in the 25-character product key 
(Certificate of Authenticity) number in the Product Key field; then, click Next. 

The setup program takes control. Several screens later, the Completing the Win-
dows 2000 Setup Wizard displays.

6. When the Completing the Windows 2000 Setup Wizard window displays, click 
Finish. 

The setup program has completed Phase 1 - personalizing the basic operating 
system.

The system reboots the operating system and the setup program begins Phase 2 
- advanced operating system configuration.

At this stage in the process, you can choose to configure the server into the net-
work in two ways. You can configure the server as a domain controller or you can 
configure the server as a member of another domain in the network.

If you want to configure the server as a domain controller, continue with the fol-
lowing steps. If you want to configure the server as a member of an existing 
domain, see “Configuring the server as a member of an existing domain” on page 
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15. Once you are done, follow steps d through q below on configuring the server 
as a domain controller.

To configure the server as a domain controller, do the following: 

a. From the desktop, double-click on the Join Domain icon. 

The Configuration Active Directory wizard starts. At this stage, the setup pro-
gram is configuring the server as a domain controller.

b. You might receive an error message if the server is not connected to a net-
work correctly. If you get a message that says: "could not form the domain", 
connect the server to the network correctly and continue clicking Next until 
you are prompted to enter your administrative password. Type in the word 
password in lowercase in the Password field; then, click Next.

c. The Insert Disk window displays. Change the path from D:\i386 to C:\i386 
then, click OK. 

The setup program configures the Active Directory. When complete, the sys-
tem automatically shuts down and reboots. When the system comes up 
again, the setup program starts the cluster configuration phase.

d. When the Welcome to Windows window displays, press Ctrl+Alt+Delete. 
The system reboots.

e. When the Log On to Windows window displays, type the word password (in 
lowercase) in the Password field; then, click OK.

f. The Windows 2000 Configuring Your Server window displays. Close this 
window.

g. Run the setup.exe in the path c:\ibm to install Microsoft Clustering Services 
and IBM ServeRAID Clustering Support.

h. When the IBM ServeRAID NT Cluster Solution information window dis-
plays, click OK.

i. When the Welcome window for IBM ServeRAID NT Cluster Solution win-
dow displays, click Next.

j. When the IBM ServeRAID Cluster Configuring Wizard window displays, 
click Next.

k. When the Cluster Service Configuring Wizard window displays, click Next. 
The setup program is installing cluster services.

l. When the Hardware Configuration window displays, click I Understand; 
then, click Next.

m. When the Create or Join Cluster window displays, select The second or 
next node in the cluster radio button; then, click Next.

n. When the Cluster Name window displays, type the user name you want to 
use for the cluster and a password in the Cluster Name and Password fields 
and select the Connect to cluster as box; then, click Next.

o. When the Select an Account window displays, type in a password for the 
domain account in the Password field (use the same password you used in 
the Select an Account window for Server 1); then, click Next.

p. When the window indicating that the configuring wizard has completed con-
figuring the cluster displays, click Finish.

q. The IBM ServeRAID NT Cluster Solution window displays and indicates 
that the setup program has completed the installation of IBM ServeRAID 
Cluster Solution. Click Finish. 

You have successfully completed cluster configuration of Server 2.
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Configuring the servers using Windows NT 4.0 Enterprise Edition
Note: You will need the 25-character Product Key (Certificate of Authenticity) num-

bers for both Server 1 and Server 2 to configuring the Netfinity HA 4500R Clus-
ter servers. The Product Key numbers are located on the Certificate of 
Authenticity that is included with your Netfinity HA 4500R Cluster.

Before you begin the configuration process, you need to do the following: 

• Keep in mind the following: 

— Ensure that the cables and power cords are connected properly.

— Ensure that the servers are connected to a working public network.

— Have the 25-character Product Key (Certificate of Authenticity (COA)) num-
ber available when you start the servers. You will need it later.

— Be sure to configure Server 1 before you configure Server 2.

• Power on the cluster components in the following sequence: 

1. The PDU and/or UPS

2. The EXP200

3. The console server selector switch

4. The flat panel monitor

Note: Do not power on either of the servers at this time.

The Windows NT 4.0 Enterprise Edition clustering setup for Netfinity HA 5100 Cluster 
will consist of five phases: 

• Phase 1 - recording information necessary to complete the installation procedure

• Phase 2 - preparing the customer environment for the cluster

• Phase 3 - installing and configuring Windows NT 4.0 Enterprise Edition

• Phase 4 - assigning permanent drive letters

• Phase 5 - setting up Microsoft Cluster Server

Recording Information Necessary for this Procedure
Before you begin the Windows NT 4.0 Enterprise Edition installation procedure, fill out 
the following table so that you will have all necessary addresses, user IDs, pass-
words, and so forth available during the installation process.

For Computer 
Domain Controller 
(PDC)

Domain Administrator User ID

Domain Administrator Password
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Preparing the Customer Environment for the Cluster
Add the two cluster servers to the Domain 

1. Using a domain Administrator user ID and corresponding password, log onto a 
domain controller that manages the domain in which the HA cluster will be 
installed. 

2. Start Server Manager (click Start -> Program -> Administrative Tools -> Server 
Manager). The Server Manager window (with the name of the domain included in 
the title bar) opens. 

3. Select Add to Domain from the Computer menu. The Add Computer to Domain 
window opens.

4. Select the Windows NT Workstation or Server radio button. 

5. Type in the computer name for Server 1 and then press Enter to add it to the 
domain. 

For Server 1 Computer Name (Host Name) for Server 1

Administrator Password for Server 1

TCP/IP Address for Public/Client Network

Subnet Mask for Public/Client Network

Default Gateway for Public/Client Network

DNS Server for Public/Client Network

WINS Server for Public/Client Network

TCP/IP Address for Private/Cluster 
Interconnect Network

Subnet Mask for Private/Cluster Interconnect 
Network

For Server 2 Computer Name (Host Name) for Server 2

Administrator Password for Server 2

TCP/IP Address for Public/Client Network

Subnet Mask for Public/Client Network

Default Gateway for Public/Client Network

DNS Server for Public/Client Network

WINS Server for Public/Client Network

TCP/IP Address for Private/Cluster 
Interconnect Network

Subnet Mask for Private/Cluster Interconnect 
Network

For Cluster Virtual 
Server (Microsoft 
Cluster Service)

Domain Name

Domain Cluster Service Account Name

Domain Cluster Service Account Password

Network Name for Primary Virtual Server 
(Cluster Name)

TCP/IP Address of Primary Virtual Server 
(Cluster TCP/IP Address)

Subnet Mask for Primary Virtual Server 
(Cluster TCP/IP Subnet Mask)

For ServeRAID 
Manager

Password for default "admin" account
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6. Type in the computer name for Server 2 and then press Enter to add it to the 
domain. 

7. Click Close.

8. Close the Server Manager window.

Add a Domain Administrator for the Cluster Server to use: 

1. From the same domain controller system, start User Manager for Domains (click 
Start -> Program -> Administrative Tools -> User Manager for Domains). 

2. Select New User from the User menu. The New User window (with the name of 
the domain included in the title bar) opens. 

3. Enter the following information in the appropriate fields: 

User Name The Domain Cluster Service Account name that you have chosen

Full Name "MSCS Cluster Service Account"

Description "Account used by MSCS to access the domain"

Password The Domain Cluster Service Account Password you have chosen

Password Confirmation
The Domain Cluster Service Account Password you have chosen

Then, uncheck the User Must Change Password at Next Logon check box, and 
check the User Cannot Change Password and Password Never Expires 
check boxes. 

4. Click Groups. The Group Membership window opens. 

5. Select Domain Admins from the Not a Member Of selection list. 

6. Click Add to add this group to the Member Of selection list. 

7. Select Domain Admins from the Member Of selection list and then click Set 
(Primary Group). 

8. Select Domain Users from the Member of selection list and then click Remove. 

9. Click OK to accept these changes and close the Group Membership window. 

10. From the New User window, click Add to create the user. The New User window 
closes when the new user is created. Then, click Cancel to close the Add User 
window. 

11. Close the User Manager window.

Installing and Configuring Windows NT 4.0 Enterprise Edition

 Installing and Configuring Windows NT on Server 1:

1. Power on Server 1. 

Note: Do not power on Server 2 at this time. 

2. The Windows NT Setup Wizard window opens. Click Next. 

3. The License Agreement window appears. Read the license agreement, select the 
I accept this agreement radio button and then click Next. 

4. The Name and Organization window opens. Type in your name and organization 
information and then click Next. 

Power on the SCSI external storage enclosure and let it run for at least one 
minute before beginning this procedure.

Important
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5. The Registration window opens. Enter the product ID, found on the Certificate of 
Authenticity included in the bundle package, and then click Next. 

6. The Computer Name window opens. Enter a computer name, or use the default 
computer name NFCBS001, and then click Next. 

7. The Administrator Account window opens. Create the Administrator account 
password for Server 1. Type the same password in the Password and Confirm 
Password fields and then click Next. 

8. Click Finish to complete the NT installation on Server 1. The server will restart 
automatically. 

9. After the server restarts and the Begin Logon window opens, press 
Ctrl+Alt+Delete to log on to Server 1. Type the Administrator username and cor-
responding password (created in step 7.) in the Username and Password fields 
and then click OK. 

10. The Welcome to Windows NT window opens. Click Close, and then use Event 
Viewer to ensure that Windows NT has started correctly. Click Start -> Programs -
> Administrative Tools -> Event Viewer to open the Windows NT Event Viewer.

11.  Use Event Viewer to check the System Event Log. Select System from the Log 
menu to display the system event log. If there are any Error events (identified by a 
red "stop sign" icon next to the event entry under the Date column), call IBM for 
support. 

12. Select Exit from the Log menu to close the Event Viewer window.

13. From the Windows NT desktop, right-click on Network Neighborhood and then 
select Properties from the pop-up menu. The Network window opens.

14. From the Network window, click the Protocols tab. Make sure that the TCP/IP 
protocol entry in the Network Protocols selection list is highlighted, and then click 
Properties. The Microsoft TCP/IP Properties window opens.
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15. Click on the IP Address tab. Then, using the information you entered in the 
Server 1 section of the network information table (see “Recording Information 
Necessary for this Procedure” on page 18), type the values for the IP Address, 
Subnet Mask and Gateway address (if applicable) for the Private/Heartbeat (Pri-
vate) and the Public/Clients (Public) network adapters. 

Before entering this data you must first select the appropriate network adapter by 
selecting it from the Adapter drop-box and then entering the TCP/IP information 
for that adapter. The network adapters that are used for the Private and the Public 
networks are:

• Netfinity 10/100 Ethernet adapter (Intel based) for the Private network 

• Netfinity Fault Tolerant Ethernet Adapter (AMD based) for the Public network 

The Netfinity Fault Tolerant Ethernet Adapter appears in the Adapter drop-box as 
(1) AMD PCnet PermaNet Server LFT adapter. The Netfinity 10/100 Ethernet 
adapter appears in the Adapter drop-box as (2) IBM Netfinity 10/100 Ethernet 
adapter.

Note: Make sure that the IBM Netfinity 10/100 Ethernet adapter is configured as 
part of the Private/Heartbeat network instead of the Public/Client network.

16. Click on the DNS tab. Enter in the Host Name field the computer name that you 
assigned to this server in step 6 on page 21. If your system is part of a DNS net-
work, enter the full domain name (for example, mydomain.ibm.com) in the 
Domain field and then click Add in the DNS Service Search Order button group 
to open the TCP/IP DNS Server window. 

17. Type in the TCP/IP address of the DNS Server and then click Add to close the 
TCP/IP DNS Server window and add the DNS Server to the DNS Service Search 
Order list. Up to three DNS Servers can be added to this list. DNS searches are 
carried out in order from the first DNS server to the last. You can select a DNS 
Server 1nd then click Up or Down to change the order in which DNS Servers are 
searched. 
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18. Click on the WINS Address tab. Select the (1) AMD PCnet PermaNet Server LFT 
adapter from the Adapter drop-box and then type the WINS Server TCP/IP 
address in the Primary WINS Server field. Do not specify the WINS Server 
TCP/IP address for the Private network adapter. Click OK to save the updated 
information and to close the Microsoft TCP/IP Properties window. 

Note: At this time a window opens asking whether you want to continue even 
though one of the network adapters has an empty WINS Server TCP/IP 
address. Click Yes to continue.

19. From the Network window, click on the Bindings tab. Select all adapters from 
the Show Bindings for drop-box. A list of the network protocols is displayed. 

20. Click the "+" sign next to the TCP/IP Protocol entry to display a list of the network 
adapters. Right-click on (1) AMD PCnet PermaNet Server LFT adapter (the 
adapter that will be used for Public communication) and select Move Up to move 
it to the top of the list of the adapters under the TCP/IP Protocol entry. 

21. Click the "+" sign next to the WINS Client (TCP/IP) entry to display a list of net-
work adapters. Click on (2) IBM Netfinity 10/100 Ethernet adapter (the adapter 
that will be used for Private communication) and then click Disable to prevent the 
WINS Server from registering this network adapter. A "stop sign" icon appears 
beside the WINS Client (TCP/IP) entry. Click OK to save the network information 
and close the Network window. When the Network Settings Change window 
opens, click No to prevent the computer from restarting. 

22. From the Windows NT desktop, right-click on My Computer and select Proper-
ties from the pop-up menu. The System Properties window opens. 

23. From the System Properties window, click the Performance tab. Then, click 
Change under the Virtual Memory field. Change the Paging File Size value in the 
Initial Size and the Maximum Size fields to the size recommended by Windows 
NT under the Total Paging File Size for All Drives box. Click Set to set the value. 
Then click OK to close the Virtual Memory window. 

24. Click Close to close the System Properties window. When asked if you want to 
restart the computer, click Yes. 

25. After the server restarts and the Begin Logon window opens, press 
Ctrl+Alt+Delete to log on to Server 1. Type the Administrator username and cor-
responding password (created in step 7 on page 21) in the Username and Pass-
word fields and then click OK.

26. Close the Welcome to Windows NT window. Then right-click on Network Neigh-
borhood icon in the desktop and select Properties from the pop-up menu. 

27. Click the Identification tab and then click Change. Select the Domain radio but-
ton from the Member of group and type the name of the domain to which you 
want to add Server 1 in the Domain field. Then click OK. After the Server 1 joins 
the domain, a pop-up window appears with a message welcoming you to the 
domain. Click OK to close the pop-up window and then click OK to close the Iden-
tification Changes window. Finally, click Close on the Network window to save the 
network changes and close the window. When asked if you want to restart the 
computer, click Yes. 

28. After the server restarts and the Begin Logon window opens, press 
Ctrl+Alt+Delete to log on to Server 1. Type the Domain Cluster Service Account 
Name and the Domain Cluster Service Account Password you created in the 
Before you Begin section (see “Recording Information Necessary for this Proce-
dure” on page 18) in the Username and Password fields. Select from the 
Domain selection list the domain name that matches the domain name that was 
used in step 27.. Click OK to logon. 

Note: If you do not have the Domain Cluster Service Account Name and Domain 
Cluster Service Account Password see “Recording Information Necessary 
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for this Procedure” on page 18 and “Preparing the Customer Environment 
for the Cluster” on page 19 or contact your network administrator. 

29. Close the Welcome to Windows NT window. You are now ready to install and con-
figure Windows NT on Server 2. 

 Installing and Configuring Windows NT on Server 2:

1. Power on Server 2. 

2. Repeat step 2 on page 20 through step 28 on page 23. 

Note: Be sure to use a new unique computer name or the Server 2 default com-
puter name NFCBS002 in step 6 on page 21. 

Assigning Permanent Drive Letters to Shared Disks
 To assign permanent drive letters from Server 1:

1. Start Disk Administrator (select Start -> Programs -> Administrative Tools (Com-
mon) -> Disk Administrator). If this is the first time you have used Disk Administra-
tor a warning window appears stating that this is either the first time that Disk 
Administrator is run or at least one or more disks had been added to the computer 
since the last time Disk Administrator is run. Click OK to continue. You may also 
be prompted with Confirm windows if Disk Administrator does not fine disk signa-
tures on the shared disks. Click Yes in the confirm windows to continue.

2. When the Disk Administrator window appears, the shared disks are listed as Free 
Space with crosshatch boxes. Right-click on the crosshatch box next to DISK 0 
and then select Create from the pop-up menu. 

3. The Create Primary Partition window opens. Click OK to accept the default size of 
the partition. A message box appears stating that the partition created may not be 
accessible from other operating systems and asks if you want to create the parti-
tion anyway. Click Yes to continue. 

Note: After the partition is created, Windows NT may still show a crosshatched 
area beside the newly created partition. The size of this area varies but is 
usually less than 50M bytes. This is not free disk space. Do not create any 
disk partitions using this space. The system will crash if disk partitions are 
created using this space.

4. Right-click on the box next to DISK 0 and select Commit Changes Now from the 
pop-up menu. A window appears asking whether you want to save the changes to 
the disk configuration. Click Yes to save the configuration and continue. A window 
appears to inform you that the disks were updated successfully. Click OK.

5. Right-click on the box next to DISK 0 and select Assign Drive Letter from the 
pop-up menu. The Assign Drive Letter window opens.

6. Select the Assign Drive Letter radio button and then select the letter Q: from the 
drop-box beside the radio button. Click OK to set the drive letter for this disk. 
When the Confirm window appears, click Yes.

7. Right-click on the box next to DISK 0 and then select Format from the pop-up 
menu.

8. From the Format window, select NTFS under File System. Type Quorum in the 
Volume Label field. Do not select any radio buttons from the Format Options 
group. Click Start to begin the formatting process on the disk. Click OK when the 
warning window is displayed to go ahead with the disk formatting process. Once 
the format has completed, click OK to clear the Format Complete information win-
dow. Then click Close to close the Format window.

9. Repeat step 4. through step 8. for the DISK 1 partition and for other shared disk 
partitions. When creating the partition for DISK 1, use drive letter R and use Data 
as the volume label. For additional shared disks, assign sequential drive letters 
starting with S and assign each volume a unique label. 
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10. Right-click on the box beside the CD-ROM entry select Assign Drive Letter from 
the pop-up menu. The Assign Drive LEtter window opens. Select the Assign Drive 
LEtter radio-button, and then select Z: from the Assign Drive Letter drop-box. 
Click OK to set the drive letter. When the Confirm window appears, click Yes.   

11. When you have finished assigning permanent drive letters to shared disks, close 
Disk Administrator by selecting Exit from the Partition menu.

To assign permanent drive letters for Server 2:

1. On Server 2, open a Windows NT Command Prompt window. Change directories 
to the C:\IBM\Cluster\SUPPORT directory. Then type 

ipshahto synchoff

and press Enter. This command transfers control of the shared disks from Server 
1 to Server 2.

2. Start Disk Administrator (select Start -> Programs -> Administrative Tools -> 
Disk Administrator). If this is the first time you have used Disk Administrator a 
warning window appears stating that this is either the first time that Disk Adminis-
trator is run or at least one or more disks had been added to the computer since 
the last time Disk Administrator was run. Click OK to continue.

3. When the Disk Administrator window opens, the formatted shared disks that you 
created on Server 1 are shown, but without their assigned permanent drive let-
ters. Add the permanent drive letters that were defined for the shared disks on 
Server 1 by right clicking on the box next to each disk entry and selecting the 
Assign Drive Letter from the pop-up menu.   Then, select the Assign Drive Let-
ter radio button and select the drive letter from the drop-box beside the radio but-
ton. 

Notes:

a. You must use the same drive letter for each shared disk as it was assigned to 
in Server 1. If you do not perform this step or do not use the same drive letters 
as in the other cluster node you will not be able to bring the Microsoft Cluster 
Disk resources online in this cluster node.

b. Windows NT may show a small crosshatch area next to the created partition 
in each shared disk. The size of the area varies but it is usually less than 50M 
bytes. This is not free disk space. Do not create any disk partitions using this 
space. The system will crash if disk partitions are created using this space.

4. When you have finished assigning permanent drive letters to shared disks, close 
Disk Administrator by selecting Exit from the Partition menu.

Complete the shared disk configuration process:

1. On Server 1, open a Windows NT Command Prompt window. Change directories 
to the C:\IBM\Cluster\SUPPORT directory. Then type 

ipshahto synchoff

and press Enter. This command transfers control of the shared disks from Server 
2 to Server 1.

2. On Server 1, start ServeRAID Manager (select Start -> Programs -> ServeRAID 
Manager -> ServeRAID Manager). 

When the ServeRAID Manager window opens, click the Server 1 (local system) 
name node on the Manage Systems tree in left window pane. Then, select 
Actions -> Configure ServeRAID Agent -> Security. If this is the first time you 
have configured the security agent, a New User window appears in addition to the 
ServeRAID Agent Security window and asks you to enter the password for the 
default security administrator "admin". Enter the same password in both the Pass-
word and Confirm Password fields and click Add to create the default security 
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administrator "admin". Select Close from the File menu to close the ServeRAID 
Agent Security window.

3. On Server 2, select Start -> Programs -> ServeRAID Manager -> ServeRAID 
Manager to start ServeRAID Manager.

When the ServeRAID Manager window opens, click the Server 2 Name node on 
the Manage Systems tree in left window pane. Then, select Actions -> Config-
ure ServeRAID Agent -> Security. If this is the first time you have configured the 
security agent, a New User window appears in addition to the ServeRAID Agent 
Security window and asks you to enter the password for the default security 
administrator "admin". Enter the same password in both the Password and Con-
firm Password fields and click Add to create the default security administrator 
"admin". Select Close from the File menu to close the ServeRAID Agent Security 
window.

4. From Server 1’s ServeRAID Manager window, click the Server 1 Name node on 
the "Manage Systems" tree in left window pane. Then, select Actions ->Validate 
Cluster. The ServeRAID Cluster Validation window opens. Type the name of 
Server 2 in the Node B field and click Start to validate the ServeRAID cluster set-
tings. A window named Connecting to Remote System appears. Enter "admin" ID 
and the corresponding password you created in step 3. in the User Name and 
Password fields. Click Connect to close the Connecting to Remote System win-
dow. The progress bar in the ServeRAID Cluster Validation window will show the 
progress of the validation process. You should not see any errors in the Prob-
lems Found panel. If there are any errors, contact IBM support.

When the validation process is complete, click Cancel to close the ServeRAID 
Cluster Validation window. Then select Exit from the File menu to close the Serv-
eRAID Manager window. 

5. On Server 2, open a Windows NT Command Prompt window. Change directories 
to the C:\IBM\Cluster\SUPPORT directory. Then type 

ipshahto synchoff

and press Enter. This command transfers control of the shared disks from Server 
1 to Server 2. Then start the Disk Administrator program on Server 2 and verify 
that the drive letter for each of the shared disks is displayed correctly. 
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6. On Server 1, open a Windows NT Command Prompt window. Change directories 
to the C:\IBM\Cluster\SUPPORT directory. Then type 

ipshahto synchoff

and press Enter. This command transfers control of the shared disks from Server 
2 to Server 1. Then start the Disk Administrator program on Server 1 and verify 
that the drive letter for each of the shared disks is displayed correctly. 

7. Repeat steps 5 on page 26 and 6. three or four times to ensure that the drive let-
ters stick to the defined share disks.

Note: If drive letters are missing, or if the are mismatches in drive letter assign-
ment, first remove the drive letters from all shared disks. Then, reassign 
the drive letters for the shared disks by right-clicking on the box beside the 
the disk drive entry (for example, Drive 0 or Drive 1), selecting the Assign 
Drive Letter radio button, and then selecting the drive letter from the drop-
box beside the Assign Drive Letter radio button.   Be sure to use the 
same drive letters for each shared disk on both servers. Then repeat steps 
5 on page 26 and 6. three or four times to ensure that the drive letters stick 
to the defined share disks. If the drive letters are still missing, or if there are 
still mismatches in drive letter assignment, call IBM for support.

8. Before going on to the MSCS cluster installation, you must synchronize the 
shared disks between the two servers at least once. 

To start the synchronization process, open a Windows NT Command Prompt on 
the server that does not own the disks. Change directories to the C:\IBM\Clus-
ter\SUPPORT directory. Then type

ipshahto synchoff

and press Enter. The Server will gain control of the shared disks and the disk 
synchronization process will be started on the shared disks. The duration of the 
synchronization process depends on the size of the shared disks. You can moni-
tor the synchronization process by running the ServeRAID Manager program on 
the Server that owns the shared disks. The bottom window pane in the Serv-
eRAID Manager window will show the synchronizing logical drive status. 
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Note: A "logical drive" is the same as a disk in Windows NT Disk Administrator.

9. Start Disk Administrator on Server 1 and verify that the drive letter for each of the 
shared disk drives is correctly displayed. If there are any mismatches, call IBM for 
support.

You are now ready to start the Microsoft Cluster Server software on Servers 1 and 
2 to form a High Availability cluster.

Microsoft Cluster Server Setup
1. Start the Microsoft Cluster Software (MSCS) installation on Server 1. Open a Win-

dow NT Command Prompt window (or click Start -> Run) and type the following 
command: 

C:\Microsoft\MSCS\Cluster\I386\setup /localquorum 

and then press Enter.

Note: The parameter "localquorum" must be typed in lowercase.

2. The Microsoft Cluster Server Setup window opens. Click Next. Then click the I 
Agree radio button to indicate that you accept the Microsoft conditions that MSCS 
software is supported only if it is installed on a hardware configuration that was 
tested for compatibility with MSCS software. Then click Next to continue.

3. Select Form a New Cluster from the Select the Operation to Perform group and 
click Next.

4. Type in the Enter the Name of the Cluster to Form or Join field the name of the 
MSCS cluster to be formed and then click Next.

Note: The name of the MSCS cluster must be unique in the Public/Client net-
work. If you choose a name that already exists in the network a warning 
will be displayed and you will need to specify another MSCS cluster name.

5. Click Next to accept the default directory for cluster software installation. The 
default directory (%systemroot%\cluster) is displayed in the Setup will place 
files in this folder field. To change the cluster software installation directory, click 
Change and then specify a different directory. Then, click Next to continue.

Note: Do not change this directory unless you have a strong technical under-
standing of the effects this can have on your MSCS installation. 

6. Type in the User Name and Password fields the Domain Cluster Service 
Account Name and Domain Cluster Service Account Password (specified in 
“Recording Information Necessary for this Procedure” on page 18). Do not 
change the Domain selection, which should already show the name of the domain 
that this system is a member of. Click Next to continue.

7. Click Next to scan for all available adapters that are installed in the Server and to 
start the configuration of the role of each network adapter in the cluster.

8. In the Network Adapter window in which IBMFE2 appears in the Adapter Name 
field, type PRIVATE in the Network Name field. Then select the Use only for 
internal cluster communications radio button and click Next to continue.

9. In the Network Adapter window in which PCNTN4M1 appears in the Adapter 
Name field, type PUBLIC in the Network Name field. Then select the Use for all 
communications radio button and click Next to continue. 

If additional network adapters are listed, you must either disable the adapter for 
cluster use or enable it only for client access. 

• To disable the adapter for cluster use, uncheck the Enable for Cluster Use 
check box.

• To enable the adapter for use only for client access, type a unique name in 
the Network Name field and then select the Use only for Client Access 
radio button. 
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 Click Next to continue.

10. When you have finished specifying the names and roles for all network adapters 
in your system a window opens that enables you to prioritize the networks that are 
available for Internal Cluster Communications. Select the Private entry and then 
click Up to move it to the top of the list and then click Next. If Private already 
appears at the top of the list, click Next to continue.

11. Next, type the TCP/IP address and the Subnet mask of the MSCS cluster in the 
TCP/IP Address and Subnet Mask fields. Do not change the values in the Net-
work field (Public should already be selected). Click Next.

12. The MSCS setup program has completed collecting all necessary information and 
is now ready to install the cluster software. Click Finish to start copying files and 
to start Microsoft Cluster service once the file copying process is completed. If 
Microsoft Cluster Service has been installed successfully, a Microsoft Cluster 
Server Setup window opens stating that the cluster software has been success-
fully installed and advising you that you must restart the server for all changes to 
take effect. Click OK to restart the server. 

Note:  If this window does not appear Microsoft Cluster Software has not been 
successfully installed. Please contact IBM for support for assistance.

13. Wait until Server 1 finishes restarting. Log into Server 1 and then open the Control 
Panel (click Start -> Settings -> Control Panel). 

14. Double-click on Services to open the Services window. Find the Cluster Server 
entry in the Services list and ensure that the word Started is listed in the Status 
column. Click Close to close the Services window and then click File -> Close to 
close the Control Panel window. 

Note: You can also verify that the Cluster Service has started by issuing a PING 
command from a Windows NT Command Prompt with the name of the 
cluster used as the destination value (for example PING MYCLUSTER). If 
the Cluster Service has started, the PING command will display messages 
that the destination responded and how long it took to receive a reply. 
However, the Cluster Service will not respond to ping commands until sev-
eral minutes after the service starts. If the cluster does not respond to the 
ping command wait 2 or 3 minutes and try again. When you have con-
firmed that the Cluster Server service has started on Server 1 you are 
ready start the cluster software installation process on Server 2 to join the 
MSCS cluster that was formed in Server 1. 

15. Start the Microsoft Cluster Software (MSCS) installation on Server 2. Open a Win-
dow NT Command Prompt window (or click Start -> Run) and type the following 
command:

C:\Microsoft\MSCS\Cluster\I386\setup

and then press Enter.

Note: Do not specify the parameter /localquorum. The localquorum parameter 
must be used only when installing MSCS to form an MSCS cluster on the 
first node or server of an MSCS cluster. 

16. The Microsoft Cluster Server Setup window opens. Click Next. Then click the I 
Agree radio button to indicate that you accept the Microsoft conditions that MSCS 
software is supported only if it is installed on a hardware configuration that was 
tested for compatibility with MSCS software. Then click Next to continue.

17. Select Join an Existing Cluster from the Select the Operation to Perform box 
and click Next.

18. Type in the Enter the name of the cluster to form or join field the name of the 
cluster that you specified in step 4 on page 28. If you do not specify the same 
name an error window will be displayed and you will need to reenter the MSCS 
cluster name. Click Next to continue.
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19. Click Next to accept the default directory for cluster software installation. The 
default directory (%systemroot%\cluster) is displayed in the Setup will place 
files in this folder field. To change the cluster software installation directory, click 
Change and then specify a different directory. Then, click Next to continue. 

Note: If you changed the installation directory in step 5 on page 28 you must 
change the installation directory for Server 2 to the same installation direc-
tory. Do not change this directory unless you have a strong technical 
understanding of the effects this can have on your MSCS installation. 

20.  In the next window, type in the Password field the Domain Cluster Service 
Account Password that you specified in “Recording Information Necessary for this 
Procedure” on page 18. The User Name and Domain fields will be grayed-out. 
Click Next.

21. The MSCS setup program has completed collecting all necessary information and 
is now ready to install the cluster software. Click Finish to start copying files and 
to start Microsoft Cluster service once the file copying process is completed. 

If Microsoft Cluster Service has been installed successfully, a Microsoft Cluster 
Server Setup window opens stating that the cluster software has been success-
fully installed and advising you that you must restart the server for all changes to 
take effect. Click OK to restart the server.

Note: If this window does not appear Microsoft Cluster Software has not been 
successfully installed. Please contact IBM for support for assistance.

22. Wait until Server 2 finishes restarting and the MSCS cluster service has started. 
Then, install the ServeRAID Windows NT Cluster Solution utility, first on Server 1 
and then on Server 2. To install this utility:

a. Open a Windows NT Command Prompt on Server 1. 

b. Change directories to make C:\IBM\Cluster the current directory. 

c. Type setup at the prompt and then press Enter to start the installation pro-
gram. 

d. The setup program displays a reminder that "sticky" drive letters must be 
assigned before running this program. Click OK to continue. 

e. The Welcome window opens. Click Next to install the software. When the 
software installation process is completed a window appears to advise you 
that the installation completed successfully. Click OK to continue to the next 
window, and then click Finish to complete the installation. 

f. Repeat steps a through e on Server 2. 

23. Use the Cluster Administrator program to ensure that the newly created MSCS 
cluster is started in both server nodes. Click Start -> Programs -> Administra-
tive Tools (Common) -> Cluster Administrator. The Open Connection to Win-
dow window opens. Type in the Cluster or Server Name field the name of the 
newly formed MSCS cluster and then click Open. A window that shows the status 
of the MSCS cluster opens in the Cluster Administrator window. Make sure that 
there are no "stop signs" next to the Server 1 or Server 2 computer names in the 
tree menu in the left window pane. 

24. Use Cluster Administrator to verify that the IPSHAH Disk Group x groups can be 
brought online in either nodes of the cluster by right-clicking on the group and 
then selecting Move Group from the pop- up menu. If an IPSHAH Disk group x 
group cannot be brought online in a node, it will either be shown as FAILED in the 
"moving to" node or will be shown as "online" in the "starting from" node as 
though the move command had never been issued. If this occurs, shutdown both 
servers and restart Server 1. Once Server 1 finishes restarting then start Server 
2. If you are still unable to bring IPSHAH Disk Group x groups online in either 
server node call IBM support. 

25. Right-click on the cluster name and choose Properties from the pop-up menu. 
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26. Click on the Quorum tab and change the quorum disk resource from Local Quo-
rum to IPSHA Disk Q: by clicking on the Quorum Resource selection list. Click 
OK to save the changes. Next, move the local quorum and the IPSHA Disk Q: 
resources to the Cluster Group by right-clicking on the resource and then select-
ing Change Group -> Cluster Group from the pop-up menu. Finally, delete the 
Local Quorum and IPSHA Disk Group 1 groups by right-clicking on the group 
name and selecting Delete from the pop- up menu. 

27. Customize the Failover/Failback properties for each shared disk group as 
needed. Then select Exit from the File menu to close the Cluster Administrator 
program. 

28. Install Windows NT Service Pack 5 (NT4SP5-i386-Full-128Bit, located in direc-
tory C:\Microsoft\Service Pack 5) or Windows NT Service Pack 6a (NT4SP6a-
i386-Full-128Bit, located in directory C:\Microsoft\Service Pack 6a) first on Server 
1 and then on Server 2. 

Notes:

a. Do not install Service Packs on both cluster server nodes at the same time. 

b. Before installing service pack in a server node, use Cluster Administrator pro-
gram to move all resources that are owned by the server node to the other 
cluster server node and to pause cluster service in the server node. To pause 
cluster service in a cluster node, right-click on the cluster node and then 
select Pause Node from the pop-up menu. After the service pack is installed 
and the node is restarted use Cluster Administrator to resume cluster service 
in the updated server node by right-clicking on the cluster node and selecting 
Resume Node from the pop-up menu. 

29. After both servers have been updated and restarted, start Cluster Administrator 
and verify that all cluster groups and resources are in an ONLINE state. Next, 
make sure that all resource groups can be brought online in either cluster node by 
right-clicking on the resource group and selecting Move Group from the pop-up 
menu. Wait until the group is "online" in the other cluster node before moving the 
group back to the previous node. If all resource groups can be moved between 
the cluster nodes MSCS is ready for use. If not, follow the troubleshooting proce-
dures outlined in the MSCS documentation. 

30. Follow the instructions in the MSCS documentation to create additional cluster 
resources such as IP Addresses, Network Names, Generic Applications and so 
forth.

Installing Netfinity Director Agent and UM Server Extensions
To install the Netfinity Director agent, perform the following steps on both servers in 
the HA Cluster:

1. Open a Window NT Command Prompt window (or click Start -> Run) and type 
the following command:

C:\IBM\Applications\Netfinity Director 2_12\setup

and then press Enter.

2. When the Information window opens, click Next to continue.

3. Select English and then click Next.

4. Click the I Agree radio button to indicate that you accept the license agreement 
and then click Next to continue.

5. Select Client Install.

6. Select all available options from the list and then click Next.

7. Click Next to accept the default installation destination directory.

8. Select Server as the platform type and the click Next.
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9. When prompted for a user ID and password, type Cluster in the Username filed 
and type Bundle in the Password field. Click Next to continue.

10. Click Next to accept the default data access port (411).

11. When prompted to select whether to install SNMP on this system, select No.

12. When prompted to select whether to add icons to the Start menu, select Yes.

13. When prompted to select whether to install Remote Control Support, select Yes.

14. When prompted to select whether to require user authorization for Remote 
Access, select Yes.

15. When prompted to select whether to replace newer files with older ones, select 
No To All.

16. When setup is complete, select Yes to restart your system and then select Fin-
ish. The system will then automatically restart.

To install UM Server Extensions for Netfinity Director perform the following steps on 
both servers in the HA Cluster:

1. Open a Window NT Command Prompt window (or click Start -> Run) and type 
the following command:

C:\IBM\Applications\Netfinity Director 2_12 Extensions\UMServer Extension 
2_12\Win\En\setup

and then press Enter.

2. When the title window opens, click Next to continue.

3. When the Welcome window opens, click Next to continue.

4. Click Next to confirm the default selection.

5. When prompted to select whether to stop the Netfinity Director Service, click Yes.

6. When prompted to select whether to read the Read Me file, click No.

7. Shutdown and restart the server.
 32 IBM® Netfinity® HA4500R Cluster: Installation Guide  



Chapter 4. Troubleshooting and initial system settings

This chapter provides information on the initial software configuration settings for Win-
dows 2000. It also provides troubleshooting information on how to recover from prob-
lems you might encounter while installing the IBM Netfinity HA 4500R Cluster 
solution. 

Windows 2000 Advanced Server initial software configuration settings
In the event of an unsuccessful system recovery or if for some reason data is lost, the 
following information can assist you in reconfiguring the software. The following table 
shows the initial software configuration settings for Windows 2000.

Windows 2000 Advanced Server Recovery Procedures

Restoring the servers original images
The Netfinity HA 4500R Cluster solution comes with two recovery CDs for each 
server. When you restore the servers, you will be restoring them back to the state they 
were in before you started the configuration process.

Restoring server 1
To restore Server 1 image to its factory-shipped configuration, do the following: 

1. Insert the Media 1 CD labeled NFCBS001.PQI into the CD-ROM drive.

2. When the second Easy Restore window displays, click Continue.

Table 2. Initial software configuration settings  

Drive partitioned and formatted as: C: NTFS 2000MB

License Mode: Per server for 25 CALs

Server 1: 
    Name = NFCBS001 
    Type = Primary Domain Controller 
    Heartbeat Ethernet Connection IP Address = 10.0.0.10        255.0.0.0 
    Public LAN Ethernet Connection IP Address = 192.168.0.1         255.255.255.0

Server 2: 
    Name = NFCBS002 
    Type = Backup Domain Controller 
    Heartbeat Ethernet Connection IP Address = 10.0.0.20        255.0.0.0 
    Public LAN Ethernet Connection IP Address = 192.168.0.2       255.255.255.0

Domain Name = NFCBD000

Administrator Password = password

Installation Directory = C:\WINNT

Networking Installed = TCP/IP

IIS Installed = No

Time Zone = Eastern Time (US and Canada

Cluster IP Address = 192.168.0.3
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3. When the Warning panel that displays, click Yes to continue restoring the image. 
Click No if you want to cancel. 

The recovery program begins to restore the original image to the server.

4. When the Drive Image window displays and asks you to insert the Media 2 CD, 
insert the CD labeled NFCBS001.002 for Server 1; then, click OK. 

Server 1 image has been successfully restored.

5. Press Ctrl+Alt+Delete to reboot the system.

Note: If you added other components to your cluster (for example, another EXP200 
unit or additional hard drives), you must manually configure the added compo-
nents into the cluster before you can access them. 

Restoring server 2
To restore Server 2 image to its factory-shipped configuration, do the following: 

1. Insert the Media 1 CD labeled NFCBS002.PQI into the CD-ROM drive.

2. When the second Easy Restore window displays, click Continue.

3. When the Warning panel that displays, click Yes to continue restoring the image. 
Click No if you want to cancel. 

The recovery program begins to restore the original image to the server.

4. When the Drive Image window displays and asks you to insert the Media 2 CD, 
insert the CD labeled NFCBS002.002 for Server 2; then, click OK. 

Server 1 image has been successfully restored.

5. Press Ctrl+Alt+Delete to reboot the system.

Note: If you added other components to your cluster (for example, another EXP200 
unit or additional hard drives), you must manually configure the added compo-
nents into the cluster before you can access them. 

Configuration after restoring the image
Note: If you are only restoring one of the servers and you have changed the settings 

of the other server network environment since it was shipped (for example, see 
the settings in Table 2 on page 33), then for the server that you are restoring, 
you will need to change the Internet Protocol Properties so it will be compatible 
with the new network. 

You must change the Internet Protocol Properties after Phase 1 of the configu-
ration process, but prior to Phase 2 of the configuration process. Refer to steps 
1 through 4 of “Configuring the server as a member of an existing domain” on 
page 15 for information on how to change the Internet Protocol Properties.

Server 1
If you have restored both servers, the configuration process is the same as “Configur-
ing server 1” on page 13. If you have restored Server 1 only, follow the steps used for 
“Configuring server 2” on page 16.

Server 2
To configure Server 2 after restoring the original image to the server, follow the steps 
for “Configuring server 2” on page 16.

Windows NT 4.0 Enterprise Edition Recovery Procedures
Use the following procedures to recover your Netfinity HA Cluster when a cluster node 
is unable to start the Microsoft Cluster Service, to recover one cluster node from NOS 
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failure, or to restore both nodes using the original disk images. These recovery proce-
dures apply only to HA Cluster Bundles that are running Windows NT 4.0 Enterprise 
Edition.

Recovering a Failed Cluster Node when it is Unable to Start Microsoft 
Cluster Service

1. Use Cluster Administrator to evict the failed cluster server node from the MSCS 
cluster. Right-click on the cluster node in the Cluster Administrator tree-view and 
select Evict Node from the pop-up menu. 

2. Use Add/Remove Programs (located in the Windows NT Control Panel) to unin-
stall Microsoft Cluster server software. Double-click on Add/Remove Programs 
in the Control Panel, select Microsoft Cluster Server from the Programs selection 
list, and then click Add/Remove to remove the cluster software. A warning mes-
sage will appear; click OK to continue with the un-installation process. A second 
warning message will appear, stating that the IBM ServeRAID Logical Disk pack-
age should be remove before un- installation of Microsoft cluster software. Click 
Yes to continue with the un-installation. Do not restart the server when the un-
installation process completes. When the window requesting whether you want to 
restart your system appears, click Cancel. 

3. In the Add/Remove Program window, select IBM ServeRAID Windows NT Cluster 
Solution from the Programs selection list and click Add/Remove to remove it 
from the failed server node. Then shutdown and restart the failed server.

4. Check the other cluster server node to ensure that it is up and the Cluster Service 
has started successfully. Then, on the failed server, open a Windows NT Com-
mand Prompt (or click Start -> Run) and type the following command to start 
installing cluster server software:

C:\Microsoft\MSCS\Cluster\I386\setup

Note: Do not specify the parameter /localquorum.

5. The Microsoft Cluster Server Setup window opens. Click Next. Then click the I 
Agree radio button to indicate that you accept the Microsoft conditions that MSCS 
software is supported only if it is installed on a hardware configuration that was 
tested for compatibility with MSCS software. Then click Next to continue.

6. Select Join an Existing Cluster from the Select the Operation to Perform box 
and click Next.

7. Type in the Enter the name of the cluster to form or join field the name of the 
cluster that you want to join. If you do not specify the same name an error window 
will be displayed and you will need to reenter the MSCS cluster name. Click Next 
to continue.

8. Click Next to accept the default directory for cluster software installation. The 
default directory (%systemroot%\cluster) is displayed in the Setup will place 
files in this folder field. To change the cluster software installation directory, click 
Change and then specify a different directory. Then, click Next to continue. 

Note: If you previously changed the installation directory in step 5 on page 28 
you must change the installation directory. Do not change this directory 
unless you have a strong technical understanding of the effects this can 
have on your MSCS installation. 

9. In the next window, type in the Password field the Domain Cluster Service 
Account Password that you specified in “Recording Information Necessary for this 
Procedure” on page 18. The User Name and Domain fields will be grayed-out. 
Click Next.

10. The MSCS setup program has completed collecting all necessary information and 
is now ready to install the cluster software. Click Finish to start copying files and 
to start Microsoft Cluster service once the file copying process is completed. 
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If Microsoft Cluster Service has been installed successfully, a Microsoft Cluster 
Server Setup window opens stating that the cluster software has been success-
fully installed and advising you that you must restart the server for all changes to 
take effect. Click OK to restart the server.

Note:  If this window does not appear Microsoft Cluster Software has not been 
successfully installed. Contact IBM for support.

11. Wait until the server finishes restarting and the MSCS cluster service has started. 
Then, install the ServeRAID Windows NT Cluster Solution utility on the server. To 
install this utility

a. Open a Windows NT Command Prompt. 

b. Change directories to make C:\IBM\Cluster the current directory. 

c. Type setup at the prompt and then press Enter to start the installation pro-
gram. 

d. The setup program displays a reminder that "sticky" drive letters must be 
assigned before running this program. Click OK to continue. 

e. The Welcome window opens. Click Next to install the software. When the 
software installation process is completed a window appears to advise you 
that the installation completed successfully. Click OK to continue to the next 
window, and then click Finish to complete the installation.

12. Install Windows NT Service Pack 5 (NT4SP5-i386-Full-128Bit, located in direc-
tory C:\Microsoft\Service Pack 5) or Windows NT Service Pack 6a (NT4SP6a-
i386-Full-128Bit, located in directory C:\Microsoft\Service Pack 6a) and then 
restart the server. 

Notes:

a. You must install the same Service Pack on both of the nodes in your cluster. 
Be sure to install the same Service Pack on the failed node as you have 
installed on the functional node of this cluster.

b. Before installing Service Pack in a server node, use Cluster Administrator 
program to pause cluster service in the failed server node. To pause cluster 
service in a cluster node, right-click on the cluster node and then select 
Pause Node from the pop-up menu. 

13. After the server restarts, use Cluster Administrator to verify that the cluster ser-
vice in the failed node has started correctly and to reconfigure the preferred 
owner for any groups which had the failed server as its preferred owner, if neces-
sary. 

14. If you have installed any MSCS cluster aware applications, please follow the 
recovery instructions that were provided with the applications to restore the appli-
cations in the failed server. 

15. Start Cluster Administrator and verify that all cluster groups and resources are in 
an ONLINE state. Next, make sure that all resource groups can be brought online 
in either cluster node by right-clicking on the resource group and selecting Move 
Group from the pop-up menu. Wait until the group is "online" in the other cluster 
node before moving the group back to the previous node. If all resource groups 
can be moved between the cluster nodes MSCS is ready for use. If not, follow the 
troubleshooting procedures outlined in the MSCS documentation. 

Recovering One Cluster Server Node from NOS Failure
Note: The cluster service on the functioning cluster node must be shut down momen-

tary in step 7 on page 37 through step 9 on page 37. If this cluster is being 
used in a mission-critical capacity schedule the cluster node recovery proce-
dure for off-peak hours to minimizing cluster downtime impact. 
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1. Use Cluster Administrator to evict the failed cluster server node from the MSCS 
cluster. Right-click on the cluster node in the Cluster Administrator tree-view and 
select Evict Node from the pop-up menu. 

2. Place the appropriate recovery CD that corresponds to the failed cluster server 
node (NTCBS1W.IMD and NTCBS2W.IMD for cluster Server 1 and B, respec-
tively) into the CD-ROM drive of the failed server and then restart the server.

3. After the server has restarted, the IBM Product Recovery Main Menu screen 
appears. Press Enter to confirm that you want to reformat your hard disk and 
restore all files in the failed server node. 

4. On each of the following screens (Terms and Conditions, Attention Read This 
Before you Continue, and Your Hard Disk will be Formatted) type Y and then 
press Enter to confirm and continue with the restore process. Type N and press 
Enter on any of these screens to abort the software recovery process. 

Note: If a window appears that states "The Program has detected on error 116 
on the partition started at sector "x" on disk "y" (where "y"=2 or 3). The LBA 
and CHS values must be the equal. Would you like The Program to fix this 
error?" click No to continue. Do not click Yes. 

5. When the restoration process has completed remove the CD from the CD-ROM 
drive and press Ctrl+Alt+Delete to restart the restored server.

6. Follow the steps in “Installing and Configuring Windows NT 4.0 Enterprise Edi-
tion” on page 20 that pertain to the server you have restored (Server 1 or Server 
2). However, when you reach step 28 on page 23 you must check the Create a 
computer account in the domain check box and then type in the User Name 
and Password fields the Domain Cluster Service Account Name and the Domain 
Cluster Service Account Password before clicking OK to enable the server to join 
a network domain. 

7. Use Cluster Administrator to stop the Cluster Service in the functional (non-failed) 
cluster server node. 

8. Open a Windows NT Command Prompt on the restored cluster and change direc-
tories to the C:\IBM\Cluster\SUPPORT directory. Then type 

ipshahto synchoff

and press Enter to transfer control of the cluster shared disks from the surviving 
cluster server node. 

9. Start Windows NT Disk Administrator (click Start-> Administrative Tools-> Disk 
Administrator) on the restored cluster server node. You will be prompted that the 
disk system configuration will be updated. Click OK to continue. 

The cluster shared disks appear, but without drive letters assigned. Right click on 
the box to the right of each of the shared disk partitions and select Assigning 
Drive Letter from the pop-up menu. The Assigning Drive Letter window opens. 
Select the appropriate disk drive letter from the pull-down list and click OK to 
assign this drive letter to the disk partition. 

Note: The drive letter for the shared disk partition must be the same in both clus-
ter server nodes.

10. Use Cluster Administrator to start Cluster Service on the functional (non-failed) 
cluster server node. The functional cluster node will take control of the shared 
disks and shared disk synchronization will be started. Wait until all of the shared 
disks complete disk synchronizing between the two cluster server nodes before 
continuing.

11. On the restored cluster server node, open a Windows NT Command Prompt (or 
click Start -> Run) and type the following command to start installing cluster 
server software: 

C:\Microsoft\MSCS\Cluster\I386\setup
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Note: Do not specify the parameter /localquorum.

12. The Microsoft Cluster Server Setup window opens. Click Next. Then click the I 
Agree radio button to indicate that you accept the Microsoft conditions that MSCS 
software is supported only if it is installed on a hardware configuration that was 
tested for compatibility with MSCS software. Then click Next to continue.

13. Select Join an Existing Cluster from the Select the Operation to Perform box 
and click Next.

14. Type in the Enter the name of the cluster to form or join field the name of the 
cluster that you want to join. If you do not specify the same name an error window 
will be displayed and you will need to reenter the MSCS cluster name. Click Next 
to continue.

15. Click Next to accept the default directory for cluster software installation. The 
default directory (%systemroot%\cluster) is displayed in the Setup will place 
files in this folder field. To change the cluster software installation directory, click 
Change and then specify a different directory. Then, click Next to continue. 

Note: If you changed the installation directory you must use the same installation 
directory. Do not change this directory unless you have a strong technical 
understanding of the effects this can have on your MSCS installation. 

16. In the next window, type in the Password field the Domain Cluster Service 
Account Password that you specified in “Recording Information Necessary for this 
Procedure” on page 18. The User Name and Domain fields will be grayed-out. 
Click Next.

17. The MSCS setup program has completed collecting all necessary information and 
is now ready to install the cluster software. Click Finish to start copying files and 
to start Microsoft Cluster service once the file copying process is completed. 

If Microsoft Cluster Service has been installed successfully, a Microsoft Cluster 
Server Setup window opens stating that the cluster software has been success-
fully installed and advising you that you must restart the server for all changes to 
take effect. Click OK to restart the server. 

Note: If this window does not appear Microsoft Cluster Software has not been 
successfully installed. Please contact IBM for support for assistance.

18. Wait until the server finishes restarting and the MSCS cluster service has started. 
Then, install the ServeRAID Windows NT Cluster Solution utility on the server. To 
install this utility

a. Open a Windows NT Command Prompt. 

b. Change directories to make C:\IBM\Cluster the current directory. 

c. Type setup at the prompt and then press Enter to start the installation pro-
gram. 

d. The setup program displays a reminder that "sticky" drive letters must be 
assigned before running this program. Click OK to continue. 

e. The Welcome window opens. Click Next to install the software. When the 
software installation process is completed a window appears to advise you 
that the installation completed successfully. Click OK to continue to the next 
window, and then click Finish to complete the installation.

19. Install Windows NT Service Pack 5 (NT4SP5-i386-Full-128Bit, located in direc-
tory C:\Microsoft\Service Pack 5) or Windows NT Service Pack 6a (NT4SP6a-
i386-Full-128Bit, located in directory C:\Microsoft\Service Pack 6a) and then 
restart the server. 

Notes:

a. You must install the same Service Pack on both of the nodes in your cluster. 
Be sure to install the same Service Pack on the failed node as you have 
installed on the functional node of this cluster.
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b. Before installing Service Pack in a server node, use Cluster Administrator 
program to pause cluster service in the failed server node. To pause cluster 
service in a cluster node, right-click on the cluster node and then select 
Pause Node from the pop-up menu. 

20. After the server restarts, use Cluster Administrator to verify that the cluster ser-
vice in the failed node has started correctly and to reconfigure the preferred 
owner for any groups which had the failed server as its preferred owner, if neces-
sary. 

21. If you have installed any MSCS cluster aware applications, please follow the 
recovery instructions that were provided with the applications to restore the appli-
cations in the failed server. 

22. Start Cluster Administrator and verify that all cluster groups and resources are in 
an ONLINE state. Next, make sure that all resource groups can be brought online 
in either cluster node by right-clicking on the resource group and selecting Move 
Group from the pop-up menu. Wait until the group is "online" in the other cluster 
node before moving the group back to the previous node. If all resource groups 
can be moved between the cluster nodes MSCS is ready for use. If not, follow the 
troubleshooting procedures outlined in the MSCS documentation.

Restoring Both Servers from the Original Images
1. Place the appropriate recovery CD that corresponds to the failed cluster server 

node (NTCBS1W.IMD and NTCBS2W.IMD for cluster Server 1 and B, respec-
tively) into the CD-ROM drive of each server and then restart the server.

2. After the server has restarted, the IBM Product Recovery Main Menu screen 
appears. Press Enter to confirm that you want to reformat your hard disk and 
restore all files in the failed server node. 

3. On each of the following screens (Terms and Conditions, Attention Read This 
Before you Continue, and Your Hard Disk will be Formatted) type Y and then 
press Enter to confirm and continue with the restore process. Type N and press 
Enter on any of these screens to abort the software recovery process. 

Note:  If a window appears that states "The Program has detected on error 116 
on the partition started at sector "x" on disk "y" (where "y"=2 or 3). The LBA 
and CHS values must be the equal. Would you like The Program to fix this 
error?" click No to continue. Do not click Yes. 

4. When the restoration process has completed remove the CD from the CD-ROM 
drive and press Ctrl+Alt+Delete keys to restart the restored server.

5. After the images have been restored to both servers, follow the instructions in 
“Installing and Configuring Windows NT 4.0 Enterprise Edition” on page 20. Per-
form the steps first on Server 1 and then on Server 2 as documented. 

Note: The cluster server node (1 or 2) that controlled the shared disks before the 
cluster stopped may display a Windows NT ERROR after performing 9 on 
page 21 of the “Installing and Configuring Windows NT 4.0 Enterprise Edi-
tion” on page 20 section. The error states that one of the services cannot 
be started and asks the user to open the Windows NT Event Viewer to find 
out which service cannot be started. This condition occurs because Win-
dows NT rearranges the disk drive letters to account for the shared disks 
and assign the server operating system (OS) disk with a different drive let-
ter than the letter C:. 

To recover from this condition, use Disk Administrator to remove drive let-
ters of all defined disks and CD-ROMs, except the OS disk. When you 
remove the drive letter from the disk with drive letter C: you may have to 
click either Yes or OK buttons in the warning screens that will be displayed 
to force the removal of the drive letter after the system is restarted. 
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Once you finish removing all of the drive letters, select Commit Changes 
Now from the File menu options to save the changes and to restart the 
server. After the server is restarted, use Disk Administrator to assign drive 
letter C: to the OS disk and the appropriate drive letters for the other 
shared disks. After you finish assigning all of the drive letters, select Com-
mit Changes Now from the File menu to save the changes and to restart 
the server. 

You can continue with step 10 on page 21 of the Installing and Configuring 
Windows NT 4.0 Enterprise Edition section after the server finish reboot-
ing. In addition, in step 27 on page 23 of the Installing and Configuring 
Windows NT 4.0 Enterprise Edition section, you must select the Create a 
computer account in the domain option box and type in the User ID and 
Password fields the Domain Cluster Service Account Name and the 
Domain Cluster Service Account Password before clicking OK to let the 
server join the network domain. 

6. After you have completed the steps in the Installing and Configuring Windows NT 
4.0 Enterprise Edition section for both cluster server nodes, open a Windows NT 
Command Prompt on Server 1 and change directories to the C:\IBM\Cluster\SUP-
PORT directory. Then type 

ipshahto synchoff

and press Enter to transfer control of the cluster shared disks from to Server 1. 

7. Start Disk Administrator on Server 1 (click Start -> Programs -> Administrative 
Tools (Common) -> Disk Administrator). If this is the first time you have used Disk 
Administrator a warning window appears stating that this is either the first time 
that Disk Administrator is run or at least one or more disks had been added to the 
computer since the last time Disk Administrator is run. Click OK to continue. You 
may also be prompted to accept the disk signatures (SID IDs) that Windows NT 
will write into the shared disks that were created from ServeRAID Manager. Click 
OK to continue. 

8. Perform step 6 on page 24 through step 8 on page 24 in the Assigning Permanent 
Drive Letters to Shared Disks section to remove and reassign the disk drive let-
ters to the shared disks. 

9. Repeat steps 6. through 8. for Server 2. Make sure that the same drive letter is 
assigned to a shared disk as it is in Server 1. 

10. Run the ipshahto synchoff command on each server to transfer control of the 
shared disks and then use Disk Administrator after the shared disks are moved to 
a given node to verify that the drive letters assigned to the shared disks does not 
change as the shared disks are moved from one server node to another. 

Note: Be sure to close Disk Administrator after each verification procedure. 

11. Perform all of the steps outlined in “Microsoft Cluster Server Setup” on page 28 to 
form the Microsoft cluster on these servers. 

12. If you have installed any MSCS cluster aware applications, you must reinstall and 
reconfigure them according to the instructions that were shipped with the applica-
tions. Once you have completed the cluster- aware application installation and 
completed all of the non-cluster customizations on the newly restored servers, 
move the cluster groups between nodes one or two times to ensure that the failed 
servers have been restored correctly and are working properly. 

Recovering a Cluster Server Node with a Failed ServeRAID Adapter
1. Use Cluster Administrator to move any cluster groups and resources that are still 

online in the server that has the failed ServeRAID adapter and stop cluster ser-
vice in that server. 
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Note: For the remainder of this section, "failed server" refers to the server that 
has the failed ServeRAID adapter. 

2. Shutdown and power off the failed server. 

3. Note and mark the SCSI cables that connect the ServeRAID adapter in the failed 
server to the external SCSI drive enclosures. 

Note: If there is more than one SCSI connection to the ServeRAID adapter, note 
and carefully mark on the SCSI cable the number of the ServeRAID 
adapter port to which it is connected. If the SCSI cables are not recon-
nected to the same ports on the new ServeRAID adapter the data in the 
external SCSI enclosure will be corrupted and the MSCS cluster to fail.

4. Open the server bay. Note and record which PCI slot that has the ServeRAID 
adapter installed and then remove the failed ServeRAID adapter.

5. Install the new ServeRAID adapter in the same PCI slot that the failed ServeRAID 
adapter was removed from. 

6. Run the program in the c:\IBM\Firmware\ServeRaid\BIOS directory of the good 
cluster node to generate a startable ServeRAID firmware/BIOS update dis-
kette(s). Follow the prompted instructions from the program. 

7. Insert the startable diskette in the failed server diskette drive and power on the 
server. The server will start directly into the IBM ROM update program window. 
The main box in the window will display the ServeRAID adapter(s) in the server 
and its current firmware (FW) and BIOS version under the "old" column. It also 
displays the FW and BIOS level of the files on the diskette under the "new" col-
umn. If the adapter FW/BIOS is older than the ones in the diskette, you will be 
given a choice to either update the adapter FW/BIOS (microcode) or canceling 
out of the update program. Use the left and right arrow keys to select Update and 
then press Enter to start the update process. 

Note: Do not power down the server during update. If the adapter FW/BIOS level 
is newer than the ones in the diskette, a "*** no updates required ***" mes-
sage will be displayed on top of the main box and one is instructed to 
select the flashing OK button to restart the server. Do not press Enter to 
restart the server. Instead, press Ctrl+F to force the IBM ROM update pro-
gram into update mode. Once the program is in update mode, press Enter 
key to start FW/BIOS updating process. Do not power down the server dur-
ing update. 

8. Once the update finishes, the status of the update will be displayed under the sta-
tus column for each of the ServeRAID adapter in the system. Make sure that Suc-
cessful is displayed in that column. Select OK and then press Enter to exit the 
IBM ROM update program. The IBM ROM update program will display a window 
with information about the fixes and changes in this FW/BIOS level. Press Enter 
to restart the server. Promptly remove the diskette from the diskette drive and 
insert the ServeRAID Manager CD that is shipped with the IBM Netfinity HA clus-
ter into the CD-ROM drive. 

Note: Do not insert the ServeRAID Manager CD that is included with the new 
adapter. You must use the ServeRAID Manager CD that is included with 
your Netfinity HA cluster. 

9. The failed server automatically starts the ServeRAID Manager. Right-click on the 
"Controller 1 (not configured)" node (from the main tree on the top left window 
panel), and select "Restore to factory default settings" from the pop-up menu. 

Do not reconnect the SCSI cables back to the new ServeRAID adapter at 
this time. The new adapter must be at the same firmware and BIOS level as 
the adapter in the other server node.

Important
 
Chapter 4.  Troubleshooting and initial system settings  41



 

Click Yes when the Confirm window is displayed to let the ServeRAID Manager 
initialize the adapter configuration. 

10. Right-click on the Controller 1 (not configured) node again and select Configure 
for Clustering from the pop-up menu. A "Configure controller 1 for clustering" win-
dow will be displayed. Enter the appropriate information in the Controller Name, 
Partner Name, and Initiator Identifier fields from the following table, depending on 
whether the failed server is Server 1 or Server 2, and then click OK to save the 
changes.

11. Right click on the Controller 1 node and then select Change stripe-unit size -> 
16KB to change the stripe- unit to 16KB from the default setting. Click Yes when 
the Confirm window appears.

12. Select Exit from the File menu to stop the ServeRAID Manager program. Remove 
the CD from the CDROM drive and power off the server. 

13. Connect the SCSI cables to the appropriate ports on the back of the ServeRAID 
adapter using the information collected in step 3 on page 41. 

14. Power up the failed server. The server should restart and the cluster service 
should be started. If possible, open Cluster Administrator and move resources 
from the good server to the failed server. Verify that all of the cluster resources 
can be brought online correctly in the failed server. 

15. (Optional) Perform step 2 on page 25 to create user "admin" as the default Serv-
eRAID manager administrator.

Server Controller Name Partner Name Initiator Identifier

Server 1 NFCBS001 NFCBS002 7

Server 2 NFCBS002 NFCBS001 6
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Appendix A.  Getting help, service, and product information

If you need help, service, technical assistance, or just want more information about 
IBM products, you will find a wide variety of sources available from IBM to assist you.

With the original purchase of an IBM hardware product, you have access to extensive 
support coverage. During the IBM hardware product warranty period, you may call the 
IBM Personal Computer HelpCenter (1-800-772-2227 in the U.S.) for hardware prod-
uct assistance covered under the terms of the IBM Statement of Limited Warranty.

The following services are available during the warranty period: 

Problem Determination
Trained personnel are available to assist you with determining if you have a 
hardware problem and deciding what action is necessary to fix the problem.

IBM Hardware Repair
If the problem is determined to be caused by IBM hardware under warranty, 
trained service personnel are available to provide the applicable level of ser-
vice.

Engineering Change Management
Occasionally, there might be changes that are required after a product has 
been sold.  IBM or your reseller, if authorized by IBM, will make Engineering 
Changes (ECs) available that apply to your hardware.

Be sure to retain your proof of purchase to obtain warranty service.  Refer to the IBM 
hardware warranty for a full explanation of IBM’s warranty terms.

Please have the following information ready when you call: 

• Machine Type and Model

• Serial numbers of your IBM hardware products

• Description of the problem

• Exact wording of any error messages

• Hardware and software configuration information

On the World Wide Web, the IBM Personal Computing Web site has up-to-date infor-
mation about IBM products and support.

Some helpful addresses are: 

You can select a country-specific Web site from these pages.

If you select Profile from the support page, you can create a customized support page 
that is specific to your hardware, complete with Frequently Asked Questions, Part 
Information, Technical Hints and Tips, and Downloadable Files.  You will have the 

Web page address Description

http://www.ibm.com Main IBM home page

http://www.ibm.com/pc IBM Personal Computing 

http://www.ibm.com/pc/support IBM Personal Computing Support

http://www.ibm.com/pc/us/accessories Options by IBM (U.S.)

http://www.ibm.com/pc/us/netfinity IBM Netfinity Servers (U.S.)

http://www.ibm.com/pc/techconnect IBM TechConnect
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information you need, all in one place.  In addition, you can choose to receive e-mail 
notifications whenever new information becomes available about your registered 
products.  You can also access online support forums, which are community sites 
monitored by IBM support staff.
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Appendix B.  Product notices

This appenix contains trademarks and general-information notices.  For warranty 
information and emission notices, see the documentation on the IBM Netfinity Docu-
mentation CD.

Notices
References in this publication to IBM products, programs, or services do not imply 
that IBM intends to make these available in all countries in which IBM operates. Any 
reference to an IBM product, program, or service is not intended to state or imply that 
only that IBM product, program, or service may be used. Subject to IBM’s valid intel-
lectual property or other legally protectable rights, any functionally equivalent product, 
program, or service may be used instead of the IBM product, program, or service. The 
evaluation and verification of operation in conjunction with other products, except 
those expressly designated by IBM, are the responsibility of the user.

IBM may have patents or pending patent applications covering subject matter in this 
document. The furnishing of this document does not give you any license to these 
patents. You can send license inquiries, in writing, to:  

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY  10504-1785
U.S.A.

This section contains trademarks, electronic emission notices, and other important 
information.

Any references in this publication to non-IBM Web sites are provided  for convenience 
only and do not in any manner serve as an endorsement of those Web sites.  The 
materials at those Web sites are not part of the materials for this IBM product and use 
of those Web sites is at your own risk.

Edition Notice
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUB-
LICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some jurisdic-
tions do not allow disclaimer of express or implied warranties in certain transactions, 
therefore, this statement may not apply to you. 

This publication could include technical inaccuracies or typographical errors. Changes 
are periodically made to the information herein; these changes will be incorporated in 
new editions of the publication. IBM may make improvements and/or changes in the 
product(s) and/or the program(s) described in this publication at any time.

This publication was developed for products and services offered in the United States 
of America and the United Kingdom. It is possible that this publication may contain 
reference to, or information about, IBM products (machines and programs), program-
ming, or services that are not announced in your country. Such references or informa-
tion must not be construed to mean that IBM intends to announce such IBM products, 
programming, or services in your country.

Requests for technical information about IBM products should be made to your IBM 
reseller or IBM marketing representative. No part of this publication may be repro-
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duced or distributed in any form or by any means without prior permission in writing 
from the International Business Machines Corporation.

© COPYRIGHT INTERNATIONAL BUSINESS MACHINES CORPORATION, 2000.  
All rights reserved. 

Note to U.S. Government Users - Documentation related to restricted rights - Use, 
duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Con-
tract with IBM Corp.

Year 2000 readiness and instructions
This is a Year 2000 Readiness Disclosure.

A product is Year 2000 Ready if the product, when used in accordance with its associ-
ated documentation, is capable of correctly processing, providing and/or receiving 
date data within and between the 20th and 21st centuries, provided all other products 
(for example, software, hardware, and firmware) used with the product properly 
exchange date data with it.

This IBM PC hardware product has been designed to process four-digit date informa-
tion correctly within and between the 20th and 21st centuries. If your IBM computer is 
on when the century changes, you should turn it off and then back on again once, or 
restart the operating system, to ensure that the internal clock resets itself for the new 
century.

This IBM PC product cannot prevent errors that might occur if software you use or 
exchange data with is not ready for the Year 2000. IBM software that comes with this 
product is Year 2000 Ready. However, software from other companies might come 
with this IBM PC product. IBM cannot take responsibility for the readiness of that soft-
ware. You should contact the software developers directly if you wish to verify readi-
ness, understand limitations, or look for any software updates.

To learn more about IBM PC products and the Year 2000, visit our Web site at 
http://www.ibm.com/pc/year2000. The information and tools there can help you with 
your Year 2000 transition plan, especially if you have multiple IBM PCs.  IBM encour-
ages you to check periodically for updated information.

Trademarks
The following terms are trademarks or registered trademarks of the IBM Corporation 
in the United States or other countries or both: 

Intel, MMX, LANDesk, Pentium, Pentium II Xeon, and Pentium III Xeon are trade-
marks or registered trademarks of Intel Corporation in the United States, other coun-
tries, or both.

Microsoft, Windows, and Windows NT are trademarks or registered trademarks of 
Microsoft Corporation.

EtherJet Netfinity Manager

HelpCenter Predictive Failure Analysis

IBM ServeRAID

Netfinity TechConnect

Netfinity Advanced System Management
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Other company, product, and service names may be trademarks or service marks of 
others.

Important notes
Processor speeds indicate the internal clock speed of the microprocessor; other fac-
tors also affect application performance.

When referring to hard disk drive capacity, MB stands for 1000000 bytes and GB 
stands for 1000000000 bytes.  Total user-accessible capacity may vary depending on 
operating environments.

Maximum internal hard disk drive capacities assume the replacement of any standard 
hard disk drives and population of all hard disk drive bays with the largest currently 
supported drives available from IBM.

Unless otherwise stated, IBM makes no representations or warranties with respect to 
non-IBM products.  Support (if any) for the non-IBM products is provided by the third 
party, not IBM.

Some software may differ from its retail version (if available), and may not include 
user manuals or all program functionality.

Power cords
For your safety, IBM provides a power cord with a grounded attachment plug to use 
with this IBM product. To avoid electrical shock, always use the power cord and plug 
with a properly grounded outlet.

IBM power cords used in the United States and Canada are listed by Underwriter’s 
Laboratories (UL) and certified by the Canadian Standards Association (CSA).

For units intended to be operated at 115 volts: Use a UL-listed and CSA-certified cord 
set consisting of a minimum 18 AWG, Type SVT or SJT, three-conductor cord, a max-
imum of 15 feet in length and a parallel blade, grounding-type attachment plug rated 
15 amperes, 125 volts.

For units intended to be operated at 230 volts (U.S. use): Use a UL-listed and CSA-
certified cord set consisting of a minimum 18 AWG, Type SVT or SJT, three-conductor 
cord, a maximum of 15 feet in length and a tandem blade, grounding-type attachment 
plug rated 15 amperes, 250 volts.

For units intended to be operated at 230 volts (outside the U.S.): Use a cord set with a 
grounding-type attachment plug. The cord set should have the appropriate safety 
approvals for the country in which the equipment will be installed.

IBM power cords for a specific country or region are usually available only in that 
country or region.

IBM power cord part 
number

Used in these countries and regions

13F9940 Argentina, Australia, China (PRC), New Zealand, Papua New Guinea, Paraguay, Uruguay, Western 
Samoa
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13F9979 Afghanistan, Algeria, Andorra, Angola, Austria, Belgium, Benin, Bulgaria, Burkina Faso, Burundi, 
Cameroon, Central African Rep., Chad, Czech Republic, Egypt, Finland, France, French Guiana, 
Germany, Greece, Guinea, Hungary, Iceland, Indonesia, Iran, Ivory Coast, Jordan, Lebanon, 
Luxembourg, Macau, Malagasy, Mali, Martinique, Mauritania, Mauritius, Monaco, Morocco, 
Mozambique, Netherlands, New Caledonia, Niger, Norway, Poland, Portugal, Romania, Senegal, 
Slovakia, Spain, Sudan, Sweden, Syria, Togo, Tunisia, Turkey, former USSR, Vietnam, former 
Yugoslavia, Zaire, Zimbabwe

13F9997 Denmark

14F0015 Bangladesh, Burma, Pakistan, South Africa, Sri Lanka

14F0033 Antigua, Bahrain, Brunei, Channel Islands, Cyprus, Dubai, Fiji, Ghana, Hong Kong, India, Iraq, Ireland, 
Kenya, Kuwait, Malawi, Malaysia, Malta, Nepal, Nigeria, Polynesia, Qatar, Sierra Leone, Singapore, 
Tanzania, Uganda, United Kingdom, Yemen, Zambia

14F0051 Liechtenstein, Switzerland

14F0069 Chile, Ethiopia, Italy, Libya, Somalia

14F0087 Israel

1838574 Thailand

62X1045 Bahamas, Barbados, Bermuda, Bolivia, Brazil, Canada, Cayman Islands, Colombia, Costa Rica, 
Dominican Republic, Ecuador, El Salvador, Guatemala, Guyana, Haiti, Honduras, Jamaica, Japan, 
Korea (South), Liberia, Mexico, Netherlands Antilles, Nicaragua, Panama, Peru, Philippines, Saudi 
Arabia, Suriname, Taiwan, Trinidad (West Indies), United States of America, Venezuela

IBM power cord part 
number

Used in these countries and regions
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